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SAFETY PRECAUTIONS
(Always read these instructions before using the products.)
When designing the system, always read the relevant manuals and give sufficient consideration to safety.
During the exercise, pay full attention to the following points and handle the product correctly.

[EXERCISE PRECAUTIONS]

WARNING
● Do not touch the terminals while the power is on to prevent electric shock.
● Before opening the safety cover, turn off the power or ensure the safety.

CAUTION
● Follow the instructor's direction during the exercise.
● Do not remove the module of the demonstration machine or change wirings without permission.

Doing so may cause failures, malfunctions, personal injuries and/or a fire.
● Turn off the power before mounting or removing the module.

Failure to do so may result in malfunctions of the module or electric shock.
● When the demonstration machine (such as X/Y table) emits abnormal odor/sound, press the "Power 

switch" or "Emergency switch" to turn off.
● When a problem occurs, notify the instructor as soon as possible.
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INTRODUCTION
To help users acquire the knowledge required for configuring a high-functionality monitoring control system using 
GENESIS64, this manual describes the functions and specifications of hardware and software used in the system and 
troubleshooting.

RELEVANT MANUALS

e-Manual refers to the Mitsubishi FA electronic book manuals that can be browsed using a dedicated tool.
e-Manual has the following features:
 • Required information can be cross-searched in multiple manuals.
 • Other manuals can be accessed from the links in the manual.
 • The hardware specifications of each part can be found from the product figures.
 • Pages that users often browse can be bookmarked.
 • Sample programs can be copied to an engineering tool.

Manual name [manual number] Description Available 
form

ICONICS Product Suite Getting Started
[BCN-P5999-1584]

Functions and operation methods of GENESIS64 PDF

GX Works3 Operating Manual
[SH-081215ENG]

System configuration, parameter settings, and online operations of GX 
Works3

e-Manual
PDF



TERMS
Unless otherwise specified, this manual uses the following terms.

Term Description
AlarmWorX64 Logger A tool for logging (recording) alarms and events

AlarmWorX64 Viewer A tool for displaying real-time and historical alarms and events in a list or chart to visualize the number of occurrences

AssetWorX A tool for centrally managing assets, from equipment to entire facility, using a hierarchical tree structure.
Map the physical world to its digital twin according to the actual structure of the enterprise, company, process, factory, 
line, etc. Assets can be organized and configured in the Workbench, optionally including alarms, customizable colors, 
icons, and drag-and-drop functionalities.

Configuration personal computer A personal computer to configure settings required for operating the MES interface module.
This computer can be shared with a server.

Database (DB) / Relational 
database (RDB)

Data management method that follows relational data model logic.
A piece of data is expressed as a collection of multiple items (fields) and a data collection is expressed as a table.
Data can be easily merged and selected using key data.

Device memory / Device Memory in a CPU module.
There are two types of devices: bit device and word device.

Engineering tool A tool for setting, programming, debugging, and maintaining programmable controllers.
For the supported tools, refer to the following.
MELSEC iQ-R Module Configuration Manual

GENESIS64 A package name for SCADA software

GraphWorX64 A tool for creating graphics (Configuration mode) and visualizing the operation of the created graphics (Runtime mode).
In Configuration mode, users can create graphics using 2D and 3D symbols (for example meters and pipes) and viewers 
(for example alarms and trends).
In Runtime mode, users can visualize acquired data and created alarms/trends on the created screens. Also, users can 
control the programmable controller operation using buttons.

GridWorX Viewer A tool for visualizing data acquired from the database on the monitoring screen

Hyper Alarm Server A tool for creating alarms. Users can create a complex logic of alarm occurrence conditions.

MES An abbreviation for Manufacturing Execution Systems.
MES is a system for controlling and monitoring the plant status in real time to optimize production activities.
The system promptly responds to changes in a production plan and status and realizes the efficient production process.

MES interface module An abbreviation for the RD81MES96 MES interface module

Mitsubishi Electric FA Connector A communication driver for connecting GENESIS64 and Mitsubishi Electric FA devices. The driver can be connected to 
MELSEC iQ-R and iQ-F series programmable controllers. It automatically detects devices on the same network.

RCPU A generic term for MELSEC iQ-R series CPU modules and MELSEC iQ-R series C Controller modules

SQL An abbreviation for Structured Query Language.
This is a database language used for operating a relational database.

TrendWorX64 Viewer A tool for providing real-time and historical data trend displays. Past data can be compared with current data in the 
displayed trend.

Workbench An integrated management application for GENESIS64 product settings and runtime operation.
This application provides a framework for security management, project management, and alarm settings.
7
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1 OVERVIEW

1.1 SCADA Software
SCADA (Supervisory Control And Data Acquisition) software, installed on the computer, controls processes, monitors 
real-time data, and acquires data from equipment in industrial systems.
The following is an example of the basic SCADA system architecture. The system includes programmable controllers, a 
SCADA server, and a SCADA client.
In the system controlled by programmable controllers, the SCADA server collects the control data of the field devices from the 
programmable controllers.
The SCADA server logs the acquired data to its database. If an abnormal value is detected, the server records an alarm log. 
The SCADA system can also display data accumulated to servers other than the SCADA server.
A SCADA client displays the acquired data, such as lamp on/off information, number of production, and number of revolutions 
and operating status of the servo motor connected, on monitoring screens that include 2D and 3D animation. Users can issue 
control instructions to the programmable controllers by entering values and operating buttons on monitoring screens.

Client

Displaying the acquired data 
on the monitoring screen
Displaying the acquired data 
on the monitoring screen
Displaying the acquired data 
on the monitoring screenLogging the acquired 

data
Logging the acquired 
data
Logging the acquired 
data

SCADA server
Database

Controlling the programmable controllers by 
entering values and operating buttons
Controlling the programmable controllers by 
entering values and operating buttons
Controlling the programmable controllers by 
entering values and operating buttons

Acquiring dataAcquiring dataAcquiring data

Programmable controllers

Acquiring dataAcquiring dataAcquiring data

Field devices
1  OVERVIEW
1.1  SCADA Software 9
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1.2 GENESIS64
Mitsubishi Electric GENESIS64 is the PC-based supervisory control and data acquisition (SCADA) software that improves 
the visibility of manufacturing operations. GENESIS64 provides a highly functional monitoring system for various industries 
and purposes, such as manufacturing process and production management control at plants, air-conditioning/lighting/power 
control at buildings and factories, and public infrastructure system control.
Two software packages are available: GENESIS64 Basic SCADA and GENESIS64 Advanced.
GENESIS64 Basic SCADA is an entry-level and cost-effective package with basic functions for monitoring and control. 
GENESIS64 Advanced is a package for large-scale systems that enable full-scale monitoring, analysis, and cloud 
collaboration on a personal computer.
GENESIS64 has functions required for a variety of fields and systems. The functions are highly customizable. Users can 
add or change the functions as desired to configure their own systems. In addition, GENESIS64 is highly compatible with the 
cloud and has advanced integration capabilities such as seamless data integration with business process management 
systems (for example ERP).

Basic functions
Function Application name Description
Project management Workbench Manages projects for configuring GENESIS64 related applications.

Graphic GraphWorX64 Creates and visualizes advanced graphics using 2D and 3D animation, symbols, and images.

Trend TrendWorX64 Displays advanced trend graphs that support split and overlapped displays.

Alarm AlarmWorX64
Hyper Alarm

Generates alarm notifications and displays alarms in a list. (Alarms can also be displayed in 
charts by type.)

Asset management AssetWorX Centrally manages assets, from equipment to entire facility, using a hierarchical tree structure.

* ICONICS Suite™ is a generic term for the integrated monitoring solutions including GENESIS64™ as the main product.
1  OVERVIEW
1.2  GENESIS64
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Features

Enhanced visibility and operability
3D graphics enable users to monitor devices from various angles with stereoscopic displays that are not achieved with 2D 
graphics.
3D graphic screens can be rotated, zoomed in, and zoomed out. In addition, the viewpoint of the screens can be shifted freely. 
Using these functions, users can monitor the entire facility as well as the details of equipment on 3D graphic screens.
Combining 3D graphic screens with 2D graphic screens, which are excellent in monitoring the operating status of equipment 
and displaying measurement data, will enhance the visibility and operability of the monitoring screens.

Enhanced reliability
With GENESIS64, users can flexibly configure a system depending on the scale of the monitoring object, from a standalone 
system to a large server-client system.
A redundant system can also be configured by having two servers, a control server and a standby server. This will enhance 
the reliability of the system.

Ethernet

Alarm
printer 

GENESIS64TM

standby server,
OPC server

GENESIS64TM

client

GENESIS64TM

control server,
OPC server

Report
printer 
1  OVERVIEW
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Web monitoring
A GENESIS64 client system supports monitoring in a web browser.
Users can access the GENESIS64 server, which works as a web server, from a client computer on the web and monitor data 
without installing software on the client computer.
Users can also monitor the operating status of equipment remotely on any mobile device such as a tablet or a smartphone.

Reduction of engineering working hours
Use of symbols pre-registered in the library reduces working hours required for designing monitoring screens.
Using the dynamic function, animation can be added to the symbols. In addition, registering tags to the symbols enables color 
switching and numerical display, which can reduce working hours required for creating scripts.

Programmable 
controller DevicesProgrammable 

controller

GENESIS64™ client

GENESIS64™ server

2D symbols

3D symbols
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Asset management using a hierarchical tree structure
AssetWorX is an international standard ANSI/ISA-95*1 compliant asset management module. Map the physical world to its 
digital twin according to the actual structure of the enterprise, company, process, factory, line, etc. Assets can be organized 
and configured in the Workbench, optionally including alarms, customizable colors, icons, and drag-and-drop functionalities. 
The runtime component provides intuitive navigation and is perfectly suited for scaling large projects, which can be easily 
achieved using the Excel based bulk asset configuration*2.
*1 International standard which defines equipment hierarchy models for physical assets in manufacturing.
*2 This is not included in GENESIS64 Basic SCADA.

Visualization of energy consumption
Energy consumption and CO2 emissions in the whole system or per equipment can be visualized by using a Mitsubishi 
Electric energy measurement device and Energy AnalytiX®, an application which displays and analyzes energy consumption.
1  OVERVIEW
1.2  GENESIS64 13



14
Preventive maintenance
Preventive maintenance of the equipment and system can be performed by combining a MES interface module, a module 
which collects production control information, and Facility AnalytiX®, an application which displays and analyzes failures and 
diagnostic information of connected devices.
The MES interface module automatically collects the operating status of the connected devices from enormous amount of 
data and uses them for the operating ratio improvement, preventive maintenance, and failure prediction.
1  OVERVIEW
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1.3 System Configuration
The following is the basic system configuration diagram of GENESIS64.
For the connection between GENESIS64 and Mitsubishi Electric FA devices, the Mitsubishi Electric FA Connector, a 
communication driver for GENESIS64, is used. For the connection between GENESIS64 and equipment/devices at the 
production site, the OPC Server is used.
The GENESIS64 server acquires and logs data via the Mitsubishi Electric FA Connector and the OPC Server.
A GENESIS64 client is used to monitor data on screens. The client can access the GENESIS64 server over a network. 
Therefore, data can be monitored remotely using a general-purpose Web browser, such as Microsoft Edge, without installing 
dedicated software.
Data can also be monitored directly on the GENESIS64 server.

GENESIS64™ client

Programmable 
controller

GENESIS64™ 
server

OPC ServerMitsubishi Electric FA Connector

Clients access and monitor data on the server 
via a web browser.

Data acquisition and logging
GENESIS64™ server acquires and logs data from the 
programmable controllers, equipment, and devices via 
the Mitsubishi Electric FA Connector and the OPC Server.

Interface between the equipment/
devices and GENESIS64™
The OPC Server can be connected to programmable 
controllers, equipment, and devices.

Interface between the programmable controllers 
and GENESIS64™
The Mitsubishi Electric FA Connector can be 
connected to MELSEC series programmable 
controllers such as MELSEC iQ-R series.

Equipment/DevicesProgrammable 
controller
1  OVERVIEW
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2 STARTUP OF DEMONSTRATION MACHINE

2.1 System Configuration
This section describes the system configuration of the demonstration machine.

*1 The IP address of the CPU module is '192.168.3.39'.
*2 The IP address of the MES interface module is '192.168.3.3'.
*3 The IP address of the personal computer is '192.168.3.100'.

Device/software Product name/description Reference
(1) Programmable 

controller system
Main base unit R35B MELSEC iQ-R Module Configuration 

ManualPower supply module R61P

CPU module*1 R04CPU MELSEC iQ-R MES Interface Module 
User's Manual (Startup)

MES interface module*2 RD81MES96 

Simple Motion module RD77GF4 (CC-Link IE Field) 

SD memory card NZ1MEM-2GBSD MELSEC iQ-R MES Interface Module 
User's Manual (Startup)

(2) MELSERVO AC 
servo

MELSERVO-J4 MR-J4-10GF1-RJ 

(3) Personal computer (shared by a server and 
configuration personal computer)*3

A personal computer on which Windows 
operates

MELSEC iQ-R MES Interface Module 
User's Manual (Startup)

Operating system Microsoft Windows 10 Professional Operating 
System (64-bit version)

Relational database Microsoft SQL Server** Express
(** indicates the version.)

Engineering tool GX Works3 SWnDND-GXW3 ('n' indicates the version.) GX Works3 Installation Instructions
GX Works3 Operating Manual

SCADA software GENESIS64 Advanced GEN64-APP Page 9 OVERVIEW

(4) GOT2000 GT2708-STBA 

(3)

(1)(2)

GENESIS64™

(4)

Ethernet 
cable

Ethernet 
(192.168.3.39)

Ethernet CH1 
(192.168.3.3)

Ethernet 
network No.1

Ethernet 
(192.168.3.100)

Database
2  STARTUP OF DEMONSTRATION MACHINE
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2.2 Wiring
This section describes the wiring of the demonstration machine.

1. Connect the following devices to a hub with Ethernet cables.
 • CPU module
 • MES interface module (Connect to the Ethernet port (CH1).)
 • GOT2000
 • Personal computer

2. Connect the AC servo to the Simple Motion module with an Ethernet cable.

GOT2000

CH1

GENESIS64™

CPU module MES interface module

Ethernet 
cable

Personal computer

Database

GENESIS64™

AC servo
Simple Motion module

Ethernet
 cable

Database

GOT2000
Personal computer
2  STARTUP OF DEMONSTRATION MACHINE
2.2  Wiring
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3 SETUP

3.1 Parameter Settings
This section describes how to check parameters and write the parameters to the CPU module using the engineering tool.

Checking parameter settings
Parameters and a program used in the exercises have already been set in the project "school_GENESIS64.gx3". Check the 
parameters set in the project "school_GENESIS64.gx3".

Operating procedure

1. Open the project "school_GENESIS64.gx3", 
and double-click [Module Configuration] in the 
Navigation window. If a dialog box regarding 
the parameter information appears, click the 
[OK] button.

2. On the "Module Configuration" window, check 
that the power supply module "R61P" is 
mounted in the power supply slot, the CPU 
module "R04CPU" is mounted in the CPU slot, 
the MES interface module "RD81MES96" is 
mounted in slot No.0, and the Simple Motion 
module "RD77GF4" is mounted in slot No.1 
(same system configuration as the actual 
demonstration machine).

Double-click!
3  SETUP
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3. On the "Input the Configuration Detailed 
Information" window, check that the start XY is 
set as follows: 
[Settings]
"RD81MES96"
Start XY: 0000
"RD77GF4"
Start XY: 0020

4. Double-click the CPU module "R04CPU".

5. Select "Memory/Device Setting" in the "Setting 
Item List" window.

6. Double-click "Device Setting".

Check!

Double-click!

Select!

Double-click!
3  SETUP
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7. Check that the device points of the retentive 
timer is set as follows: 
[Settings]
Points: 32

8. Close the "CPU Parameter" window.

9. Double-click the Simple Motion module 
"RD77GF4".

10. Select "Required Settings" in the "Setting Item 
List" window.

11. Check that the parameters are set as follows: 
[Settings]
Station Type: Master Station
Network No.: 1

Check!

Double-click!

Check!Select!
3  SETUP
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12. Select "Basic Settings" in the "Setting Item 
List" window.

13.Double-click "Network Configuration Settings".

14. "MR-J4-GF" is added to the station list on the 
"CC IE Field Configuration" window. Check that 
the parameters are set as follows: 
[Settings]
RWw/RWr Setting Start: 0000
RWw/RWr Setting End: 0023

Double-click!

Select!

Check!
3  SETUP
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Sequence program

Devices used in the program

Precautions
 • This manual does not cover the devices of the Simple Motion module and the servo amplifier. For details, refer to the user's 

manual for each module used.
 • Programming is not included in this exercise. The pre-programmed project "school_GENESIS64.gx3" is used.

Device name Description Device name Description
X400 Start ST0 Timer

X410 Pause M10 Timer start trigger

X420 Stop D300 Volume of water in the tank

Y430 Operating status D310 Volume of water in the container

Y440 Normal D320 Flow rate

Y450 Error D330 Air pressure in the tank

SM400 Always On D340 Timer current value (for display on monitoring screens)
3  SETUP
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Sequence program
For details on each instruction, refer to the following.
MELSEC iQ-R Programming Manual (Instructions, Standard Functions/Function Blocks)

Start
1 2 3 4 5 6 7 8 9 10 11 12

1

2 (0)
X400

SET M10

3 SET Y430

4 (11)
M10

OUT ST0 K170

5 (16) > K40 D330 < K0 D330 SET Y440

6 < K20 D330 RST Y450

7 (27) <= K40 D330 < K0 D330 RST Y440

8 >= K20 D330 SET Y450

9 (38) = K10 ST0 MOV K5 D320

10 MOV K30 D330

11 (45) = K20 ST0 MOV K10 D320

12 (50) = K30 ST0 MOV K15 D320

13 (55) = K40 ST0 MOV K20 D320

14 (60) = K50 ST0 MOV K5 D300

15 MOV K15 D320

16 MOV K35 D330

17 (69) = K60 ST0 MOV K10 D300

18 MOV K10 D320

19 MOV K40 D330

20 (78) = K70 ST0 MOV K15 D300

21 MOV K5 D320

22 (85) = K80 ST0 MOV K20 D300

23 MOV K0 D320

24 MOV K30 D330

Start
3  SETUP
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1 2 3 4 5 6 7 8 9 10 11 12

25 (94) = K90 ST0 MOV K15 D300

26 MOV K5 D320

27 MOV K25 D330

28 (103) = K100 ST0 MOV K10 D300

29 MOV K10 D320

30 MOV K20 D330

31 (112) = K110 ST0 MOV K5 D300

32 MOV K15 D320

33 (119) = K120 ST0 MOV K0 D300

34 MOV K20 D320

35 MOV K30 D330

36 (128) = K130 ST0 MOV K5 D310

37 MOV K15 D320

38 (135) = K140 ST0 MOV K10 D310

39 MOV K10 D320

40 (142) = K150 ST0 MOV K15 D310

41 MOV K5 D320

42 (149) = K160 ST0 MOV K20 D310

43 MOV K0 D320

44 (156) = K170 ST0 RST ST0

45 RST D310
3  SETUP
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1 2 3 4 5 6 7 8 9 10 11 12
Pause46

47 (165)
X410

RST M10

48 RST Y430

Stop49

50 (176)
X420

MOV K0 D300

51 MOV K0 D310

52 MOV K0 D320

53 MOV K0 D330

54 RST ST0

55 RST M10

56 RST Y430

57 RST Y440

58 RST Y450

Post-processing59

60 (200)
SM400

MOV ST0 D340

61 (220) END
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Connection destination specification
This section describes how to specify the connection destination.

Operating procedure

1. On the engineering tool, select [Online]  
[Current Connection Destination] from the 
menu.

2. Click the [CPU Module Direct Coupled Setting] 
button on the "Specify Connection Destination 
Connection" window. The "CPU Module Direct 
Coupled Setting" dialog box appears.

3. Select a direct connection method with the 
CPU module, and click the [Yes] button.

4. Select "No Specification" for "Other Station 
Setting" on the "Specify Connection 
Destination Connection" window.

Select!

Click!

Click!

Select!
3  SETUP
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5. Click the [Connection Test] button.

6. Check that the connection with the CPU 
module has been successfully established.

7. Click the [OK] button.

Click!

Click!
3  SETUP
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Writing parameters to the CPU module
Write the parameters set with GX Works3 to the CPU module.

1. Open the project "school_GENESIS64.gx3". 
On the engineering tool, select [Online]  
[Write to PLC] from the menu.

2. The "Online Data Operation" window appears. 
Select the write target items. The module 
extended parameters are written to the 
intelligent function module. Select the 
"Intelligent Function Module" checkbox.

3. Click the [Execute] button.

4. The "Write to PLC" window appears. When 
completed, a message, "Writing Completed", is 
displayed. Click the [Close] button.

Select!

Select!

Click!

Click!
3  SETUP
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4 EXERCISE 1 CREATING AN OPERATION 
MONITORING SCREEN

4.1 Overview
In this exercise, we create a screen assuming a part of production process at a beverage factory and practice how to monitor 
the operating status of the system using animation, alarms, and trend graphs.

Screen to be created
The following is the screen to be created in this exercise.

*1 The display (real-time or historical) can be changed by switching tabs.

Operation to be checked
The screen created in this exercise operates as follows:

1. Water starts to flow into the tank through Pipe A. 
Flow of water:  Pipe A   Tank   Pipe B   Container

No. Name Description
(1) Alarm*1 Real-time An alarm is displayed when the air pressure in the tank is abnormal.

An alarm is generated by comparing the air pressure value with a threshold value.
Only the latest alarm is displayed here.

Historical An alarm is displayed when the air pressure in the tank is abnormal.
An alarm is generated by comparing the air pressure value with a threshold value.
The alarm history (all alarms occurred) is displayed here.

(2) Graphic screen (3D viewport) A part of production process is displayed in animation.
The animation assumes a packaging process of water filtered in the tank.

(3) Trend graph The time series data of air pressure in the tank is displayed in a line graph.

(1)

(2)

(3)
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2. The air pressure in the tank is displayed in a trend graph.

3. An alarm is displayed when the air pressure in the tank becomes above or below the threshold value at the time of water 
supply or drainage.

�

�

�

�
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Operation of GOT screen
This section describes how to operate the GOT screen used in this exercise.
Use GOT2000.

In this exercise, we use GOT to check operation. However, buttons and text objects can be placed also on the 
GraphWorX64 screen in the same way as the GOT.
The GraphWorX64 screen can also be used to check operation.

No. Name Description
(1) Lamp Run This lamp is on during system operation.

Normal This lamp is on when the air pressure in the tank is normal.

Error This lamp turns on when the air pressure in the tank becomes abnormal.

(2) Switch Start This switch starts the system and animation.

Pause This switch temporarily stops the system and animation.

Stop This switch stops the system and returns the animation back to default.

(3) Numerical display Flow rate This area displays the flow rate within Pipe A or Pipe B.

Volume This area displays the volume of water in the tank.

Air pressure This area displays the air pressure in the tank.

(1)

(2)

(3)
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4.2 Creating a Project and Checking Operation
GENESIS64 provides two modes: Configuration mode for engineering and Runtime mode for operation.
The figures below show the data flow in each mode.
In Configuration mode, the Workbench, which is an integrated management application, is used to set a project.
The settings configured in the Workbench are automatically stored in a Microsoft SQL Server database.
GraphWorX64 is used to create graphic screens, set animations, place trend graphs, and perform other operations.
In Runtime mode, according to the settings configured and the graphic screens created in Configuration mode, GENESIS64 
requests data, displays the received data on the screen, and monitors alarms.
In this exercise, GENESIS64 sends/receives asset management data to/from AssetWorX. However, GENESIS64 can 
also sends/receives data directly to/from the Mitsubishi Electric FA Connector.*1

*1 GENESIS64 Advanced only

GENESIS64TMGENESIS64TMGENESIS64TM GENESIS64TMGENESIS64TMGENESIS64TM

Configuration mode 
(for engineering)

Runtime mode
 (for operation)

Microsoft SQL ServerMicrosoft SQL ServerMicrosoft SQL Server

GraphWorXTM64
(AlarmWorXTM64 Viewer)
GraphWorXTM64
(AlarmWorXTM64 Viewer)
GraphWorXTM64
(AlarmWorXTM64 Viewer)

TM

Hyper Alarm 
ServerTM

Hyper Alarm 
ServerTM

Microsoft SQL ServerMicrosoft SQL ServerMicrosoft SQL Server

GraphWorXTM64
(AlarmWorXTM64 Viewer)
GraphWorXTM64
(AlarmWorXTM64 Viewer)
GraphWorXTM64
(AlarmWorXTM64 Viewer)

Mitsubishi Electric FA ConnectorMitsubishi Electric FA ConnectorMitsubishi Electric FA Connector

設定を反映設定を反映設定を反映

Setting tagsSetting tagsSetting tags

Setting alarmsSetting alarms

TMAssetWorXTMAssetWorXTM

WorkbenchWorkbench

Configuring the 
asset tree
Configuring the 
asset tree

Creating a monitoring screenCreating a monitoring screenCreating a monitoring screen Displaying a monitoring screenDisplaying a monitoring screenDisplaying a monitoring screen

Reflecting the settingsReflecting the settingsReflecting the settings

Reflecting the settingsReflecting the settingsReflecting the settings

Reflecting 
the settings
Reflecting 
the settings
Reflecting 
the settings

Saving 
the settings
Saving 
the settings
Saving 
the settings

TM

Hyper Alarm 
ServerTM

Hyper Alarm 
ServerTM

Mitsubishi Electric FA ConnectorMitsubishi Electric FA ConnectorMitsubishi Electric FA Connector
Acquiring device dataAcquiring device dataAcquiring device data

Detecting alarmsDetecting alarms

TMAssetWorXTMAssetWorXTM

WorkbenchWorkbench

Performing asset-based 
data management
Performing asset-based 
data management

Requesting/
returning data
Requesting/
returning data
Requesting/
returning data

Sending dataSending dataSending data

Sending/
receiving 
data

Sending/
receiving 
data

Sending/
receiving 
data

Sending/receiving dataSending/receiving dataSending/receiving data

Reflecting 
the settings
Reflecting 
the settings
Reflecting 
the settings
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4.3 Operating Procedure
The following is the operating procedure of this exercise.

Operating procedure

Page 36 Setting Tags

Page 46 Configuring the Asset Tree

Page 59 Creating a Graphic Screen
Page 73 Setting Animation

Page 78 Checking the Operation on the Graphic Screen

Page 80 Creating a Trend Graph

Page 86 Checking the Operation of the Trend Graph

Page 87 Setting an Alarm

Page 107 Creating an Alarm Viewer

Page 117 Checking the Operation of the Alarm Viewer

1. Creating tags that are associated with devices in 
the programmable controller 
Tool: Workbench

2. Building the asset tree
Tool: Workbench

3. Creating a graphic screen and setting animation
Tool: GraphWorX™64

4. Checking the operation on the graphic screen
Tool: GraphWorX™64

5. Creating a trend graph
Tool: GraphWorX™64

6. Checking the operation of the trend graph
Tool: GraphWorX™64

7. Setting alarms
Tool: Workbench

8. Creating an alarm viewer
Tool: GraphWorX™64

9. Checking the operation of the alarm viewer
Tool: GraphWorX™64
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4.4 Setting Tags
This section describes how to set tags in the Workbench.
By setting information on the demonstration machine and data of the devices used in the sequence program to the Mitsubishi 
Electric FA Connector in the form of tags, data can be sent/received to/from the demonstration machine.

Starting the Workbench
Start the Workbench.

Operating procedure

1. Select [ICONICS Product Suite]  [Workbench] from 
Windows Start.

2. The Workbench starts up.

1. Select!
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Screen configuration
The following is the screen configuration of the Workbench.

No. Name Description
(1) Ribbon A user interface to control the Workbench. Elements for managing databases and setting 

applications are placed on several tabs.

(2) Project Explorer A window that allows users to manage application settings, such as alarm settings and 
database connection settings

(3) Project Details A window that displays applications included in the item selected in the Project Explorer 
window and details of the selected application

(4) Content area An area for setting the application selected in the Project Explorer window

(5) Docking window Data Browser A window that displays data browsers in the Workbench and tasks being executed

Recent Tasks

(1)

(2)

(3) (4) (5)
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4.4  Setting Tags 37



38
Setting a communication target device
Set information on the demonstration machine so that the Mitsubishi Electric FA Connector can communicate with the 
demonstration machine.
(The IP address of the CPU module to be connected is '192.168.3.39'.)

Operating procedure

1. Select [MyProject (01.00.000.00)]  [Data Connectivity] 
 [Mitsubishi Electric] in the "Project Explorer" window. 
Right-click on [Mitsubishi Electric], and select [Network 
Discovery].

2. Click the [Start Discovery] button.

3. Select the CPU module of the demonstration machine.

4. Click the [Import] button.

1. Select!

2. Click!

3. Select! 4. Click!
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5. Click the [OK] button.

6. Double-click [R04_1(R04)].

7. Click the "(Click to test the communication)" link of 
"Common Settings".

8. Check that the connection to the CPU module has been 
successfully established.

9. Click the [OK] button.

5. Click!

6. Double-click!

7. Click!

9. Click!
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Creating tags
To send/receive data to/from the Mitsubishi Electric FA Connector, create tags and set devices used in the sequence program.
In this exercise, we create one tag on the setting screen in the Workbench. For other tags, we define them in an external file 
and import them from the file to the Workbench.

Creating tags

Operating procedure

1. Right-click on [R04_1(R04)], and select [Add Tag 
Group].

2. Set the following: 
[Settings]
Name: TagGroup

3. Click the "+ Click here to add new item" link under "Tag 
Settings", and set the following:

Settings Description

Name Enable Use Tag name for 
I/O Address

I/O Address Data Type Polling Rate

Tag000 Selected Deselected D300 WORD Default (1000 
milliseconds)

Volume of water in the tank

4. Click the [Apply] button.

1. Select!

2. Set!

3. Click!

4. Click!
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Importing tags

Operating procedure

1. Right-click on [R04_1(R04)], and select [Export 
selected].

2. Set "Export Settings" as follows: 
[Settings]
Format: Excel

3. Click the [OK] button.

4. Click the [OK] button.

5. The message on the left is displayed. Click the "(Click 
here to open task panel for details)" link.

1. Select!

3. Click!

2. Set!

4. Click!

5. Click!

Task name
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6. Right-click on the task name displayed in "Recent 
Tasks", and select [Download Export File].

7. Specify the file save destination, and click the [Save] 
button.

8. Open the file saved in Step 7 in Excel. The 
"MelcoMelsecTag" sheet is displayed.

9. Copy the 2nd row to the 3rd to 5th rows, and change the 
data as follows:

Target row Settings

Name IoAddress
3rd row Tag001 D310

4th row Tag002 D330

5th row Tag003 D340

Task name

6. Select!

7. Click!
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 • Details of the tags to be added

Settings Description

Name Enable Use Tag name for 
I/O Address

I/O Address Data Type Polling Rate

Tag001 Selected Deselected D310 WORD Default (1000 
milliseconds)

Volume of water in the container

Tag002 Selected Deselected D330 WORD Default (1000 
milliseconds)

Air pressure in the tank

Tag003 Selected Deselected D340 WORD Default (1000 
milliseconds)

Timer current value

10.Save the changes to the file.

11. Return to the Workbench, right-click on [R04_1(R04)], 
and select [Import].

12.Set "Import Settings" as follows: 
[Settings]
Only Create new items

13.Click  to open the "File" browser, and specify the 
file saved in Step 10.

14.Click the [Open] button.

11. Select!

12. Set!

13. Click!

14. Click!
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15.Click the [OK] button.

16. The message on the left is displayed. Right-click on 
[TagGroup], and select [Refresh].

17.Check that the tags are added.

15. Click!

16. Select!

17. Check!
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Activating the device
Activate the device set to the Mitsubishi Electric FA Connector to start sending/receiving data to/from the demonstration 
machine.

Operating procedure

When the device is active, the device settings cannot be changed. To change the device settings, select 
[Disable Device].
Even when the device is active, the tag settings can be changed.

1. Right-click on [R04_1(R04)], and select [Activate 
Device].

2. Data communications with the CPU module start.

1. Select!
4  EXERCISE 1 CREATING AN OPERATION MONITORING SCREEN
4.4  Setting Tags 45



46
4.5 Configuring the Asset Tree
This section describes how to build an asset tree in the Workbench.
In this exercise, we build the following asset tree.

Data of equipment is managed as equipment properties. Data to be displayed on screens or in tables, such as programmable 
controller devices and data sources, is linked to the equipment properties.

■Asset tree

Equipment property

• Timer

• Air pressure in the tank
• Volume of water in the tank

• Volume of water in the container

Equipment Module

Process cell

Unit

Equipment hierarchy
■Structure

Control Module

Bottled water production line

Filling machine

Tank

Level gauge

Equipment configuration

Equipment properties
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Creating a database
Create a database to store asset tree settings and alarm settings.
One database stores the following settings:
 • Asset tree settings
 • Real-time alarm settings
 • Historical alarm settings
In this exercise, we set alarms in the asset tree. The asset tree settings and the real-time alarm settings need to be stored in 
the same database.
For how to set alarms, refer to the following.
Page 87 Setting an Alarm

Operating procedure

1. Start the Workbench, and click the [Configure] button in 
the [Project] tab.

2. Set "Connection Settings" as follows: 
[Settings]
Database: SCHOOL

3. Click the [Next] button.

1. Click!

2. Set!

3. Click!
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4. Click the [Next] button.

5. Set the installation target application options as follows:

6. Click the [Install] button.

Settings Settings to be stored

Application Name Install/Overwrite
AlarmWorX64 Logger Selected Historical alarm settings

Assets Selected Asset tree settings

Hyper Alarm Server Selected Real-time alarm settings

Hyper Alarm Server - AssetWorX integra Selected

7. Click the [OK] button.

4. Click!

6. Click!

7. Click!
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When setting real-time alarms to the asset tree as we do in this exercise, set the same catalog for the 
following applications.
 • Assets
 • Hyper Alarm Server

 • Hyper Alarm Server - AssetWorX integration

8. Select [MyProject (01.00.000.00)] in the "Project 
Explorer" window.

9. Click the [Configure Application(s) settings] button in the 
[Home] tab.

10. In the [Applications] tab, set a catalog for the 
applications as follows:

Settings

Name Catalog
AlarmWorX64 Logger SCHOOL

Assets SCHOOL

Hyper Alarm Server SCHOOL

Hyper Alarm Server - AssetWorX integration SCHOOL

8. Select!

9. Click!
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11. Click the [Apply] button.

12.Click the [OK] button.

11. Click!

12. Click!
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Creating an equipment hierarchy
Define tiers in the equipment hierarchy to control the asset tree structure in AssetWorX.

Operating procedure

1. Start the Workbench, and select [MyProject 
(01.00.000.00)]  [Assets]  [Product configuration]  
[Equipment hierarchy] in the "Project Explorer" window. 
Double-click [Equipment hierarchy].

2. Select the 1st row, and press the  key.

3. Delete the rows named "Site" and "Area" in the same 
way as Step 2.

4. Click the [Apply] button.

1. Double-click!

2. Delete!

3. Delete!

4. Click!
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Adding equipment to the asset tree
Build an asset tree in AssetWorX.
Add pieces of equipment to the asset tree one by one.

Operating procedure

1. Select [MyProject (01.00.000.00)][Assets]  
[Equipment] in the "Project Explorer" window. Right-click 
on [Equipment], and select [Add Equipment].

2. Set the following: 
[Settings]
Name: Bottled water production line

3. Click the [Apply] button.

4. Right-click on [Bottled water production line], and select 
[Add Equipment].

5. Set the following: 
[Settings]
Name: Filling machine

6. Click the [Apply] button.

1. Select!

2. Set!

3. Click!

4. Select!

5. Set!

6. Click!
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7. Add [Tank] to [Filling machine] in the same way.

8. Add [Level gauge] to [Tank] in the same way.
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Setting equipment properties
Set the data of equipment as equipment properties.
Link the equipment properties with the tags set to the Mitsubishi Electric FA Connector.
In this exercise, we create one equipment property on the setting screen in the Workbench. For other equipment properties, 
we define them in an external file and import them from the file to the Workbench.

Setting equipment properties

Operating procedure

1. Right-click on [Level gauge], and select [Add Equipment 
property].

2. Set the following: 
[Settings]
Name: Volume of water in the tank

3. Set the following in the [Real-time Data] tab: 
[Settings]
Source type: Dynamic tag

4. Click  to open the "Real-time Data" browser.

1. Select!

2. Set!

3. Set!

4. Click!
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5. Select [My Computer]  [Data Connectivity]  
[Mitsubishi Electric]  [R04_1]  [TagGroup]  
[Tag000], and click the [OK] button.

6. Click the [Apply] button.

5. Click!

6. Click!
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Importing equipment properties

Operating procedure

 • Equipment properties to be added

1. Right-click on [Bottled water production line], and select 
[Export selected].

2. Save the imported file referring to the procedure 
described on Page 41 Importing tags.

3. Open the file saved in Step 2 in Excel. The 
"EquipmentProperty" sheet is displayed.

4. Copy the 2nd row to the 3rd to 5th rows, and change the 
data as follows:

Target row Settings

{LocationPath} Name RealtimePointName
3rd row Not changed Volume of water in the container mel:R04_1:TagGroup/Tag001

4th row Not changed Air pressure in the tank mel:R04_1:TagGroup/Tag002

5th row EquipmentRoot\Bottled water production line\Filling 
machine\Tank

Timer mel:R04_1:TagGroup/Tag003

Settings

Target equipment Name Real-time Data

Source type Real-time data tag
Level gauge Volume of water in the container Dynamic tag Tag001

Level gauge Air pressure in the tank Dynamic tag Tag002

Tank Timer Dynamic tag Tag003

1. Select!
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5. Save the changes to the file.

6. Return to the Workbench, right-click on [Bottled water 
production line], and select [Import].

7. Set "Import Settings" as follows: 
[Settings]
Import Mode: Only Create new items
File: The file saved in Step 5
Ignore GUID: Selected

8. Click the [OK] button.

6. Select!

8. Click!

7. Set!
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9. The import completed message appears. Right-click on 
[Bottled water production line], and select [Refresh].

10.Check that the equipment properties are added.

9. Select!
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4.6 Creating a Graphic Screen
This section describes how to create a graphic screen using GraphWorX64.
In this exercise, 3D model data created in advance is used to create a graphic screen.

Starting GraphWorX64
Start GraphWorX64.

Operating procedure

1. Select [ICONICS Product Suite]  [GraphWorX64] from 
Windows Start.

2. GraphWorX64 starts up.

Select!
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Screen configuration
The following is the screen configuration of GraphWorX64.

No. Name Description
(1) Ribbon This area is used to operate GraphWorX64, for example, adding objects and showing/hiding 

icons by switching tabs.

(2) Docking window Explorer This window lists all of the objects placed on the screen and is used to lock, show, and hide 
those objects.
All of the components defined in GraphWorX64 are listed here.

Data Browser

Symbols

Toolbox

(3) Screen: Canvas A user places graphics and objects here to create a monitoring screen.

(4) Docking window Properties This window is used to set properties and dynamics to the objects placed on the screen.

Dynamics

Preferences

(5) Status bar This area displays the status of GraphWorX64.

(1)

(2)

(3) (4)
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Importing 3D model data
Import the 3D model data of the factory system.

Operating procedure

*1 The mode must be set to "Desktop App" in the status bar. (Default: Desktop App)

1. Click the [3D View] button in the [Home] tab*1, and drag 
the cursor to place the 3D view port in a desired size.

2. Click the  button in the [Home] tab, select [Show 
Grid], and deselect the [Toggle Grid Plane XZ] checkbox 
to hide the gridlines.

Click!

2. Deselect!
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3. Select [File]  [Import] from the menu.

4. Select the "3DModel.3DS" file, and click the [Open] 
button.

5. Select "Scale to fit grid", and click the [OK] button.

Select!

Click!

Click!
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6. The 3D model data selected is imported to the 3D 
viewport.

7. Click the [Projection Modes] button in the [Home] tab, 
and select [Front].

8. Select [3D View].

9. Select "Gray (R: 63, G: 63, B: 63)" from the color palette 
in the [Home] tab to change the background color of the 
3D viewport.

7. Click!

8. Select!

Select!
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10.Select the GraphWorX64 screen.

11. Select "Black (R: 0, G: 0, B: 0)" from the color palette in 
the [Home] tab to change the background color of the 
GraphWorX64 screen.

Select!
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Creating a 3D object
Create a 3D object for water in the tank.

Operating procedure

1. Double-click the 3D object.

2. Click  in the [Home] tab.

2. Click!
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3. Select the [Properties] tab, and set "Appearance" as 
follows: 
[Settings]
Radius1: 2.75
Radius2: 2.15
Sides: 36
Height: 4

4. Move the [3D Model] hierarchy above the [Cone] 
hierarchy under [3D View] in the [Explorer] tab.

3. Set!

4. Move!
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5. Click the  button in the [Home] tab, select [Show 
Grid], and select the [Toggle Grid Plane XZ] checkbox to 
show the gridlines. In the same way, select the [Toggle 
Grid Plane XY] and [Toggle Grid Plane YZ] checkboxes 
to show the respective gridlines.

6. Click the [Move] button in the [Home] tab.

5. Select!

6. Click!
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To align the object more precisely, hold down the  key and the scroll wheel at the same time, and click and 
drag the object. The object can be moved freely (up or down, left or right) with a clicked point as a center.

7. Select the cone object. The move manipulator icon 
appears on the selected object. Click and drag the icon 
to move the object, and align the object position to the 
bottom of the tank.

8. Select [3D View]  [3D Model] in the [Explorer] tab, and 
click  of [3D Model] to hide the 3D model object.

7. Drag!

8. Click!
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9. Check the gridlines and the object position, and move 
the object so that its position is aligned with the hidden 
tank position. (Display the 3D model object again as 
necessary.)

10.Click  (Only vertices can be selected) in the [Home] 
tab.

11. Select the object, and click the light blue area enclosed 
by the X- and Y-axis arrows.

10. Click!

11. Click!
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12.Move the lower [3D Model] (Tank) hierarchy above the 
upper [3D Model] (Cone) hierarchy in the [Explorer] tab 
in the same way as Step 4. Then, click  of [3D Model] 
to show the 3D model object.

13.Click the [Projection Modes] button in the [Home] tab, 
and select [Perspective].

Click!12.

Move!

Click!13.
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14.Check that the corn object position is aligned with the 
tank position referring to the gridlines.

15.Click the  button in the [Home] tab, select [Show 
Grid], and deselect the [Toggle Grid Plane XZ] checkbox 
to hide the gridlines. In the same way, deselect the 
[Toggle Grid Plane XY] and [Toggle Grid Plane YZ] 
checkboxes to hide the respective gridlines.

16.Select [3D View]  [3D Model] in the [Explorer] tab, 
right-click on [3D Model], and select [Ungroup]. (The 
imported 3D model object is ungrouped.)

15. Deselect!

Select!16.
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17.Select the [3D Geometry] hierarchy in [3D View]  [3D 
Model], move the hierarchy into [3D View]  [3D Model] 
 [__RootModelsGroup], and change the object name 
to "tankwater" in the [Explorer] tab. (Move the object 
created using GraphWorX64 into the imported 3D 
model hierarchy.)

18.Select [3D View]  [3D Model] in the [Explorer] tab, and 
press the  key. (Delete the emptied 3D model 
hierarchy.)

19.Click the 3D model holding down the  key, and drag 
it in order to adjust the center.

Move!17.

Select!18.
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4.7 Setting Animation
This section describes how to set dynamic parameters to the created objects.
By setting dynamic parameters, the objects behave in conjunction with the real-time data of the equipment properties.

Setting the Hide dynamic
Set a dynamic for switching the show/hide status of objects to create animation.
The animation of the water flowing in the pipe is realized by switching the show/hide status of multiple objects with a lapse of 
time.

Operating procedure

1. Select "Advanced Mode" for "Application Mode" in the 
[View] tab.

2. Select [3D View]  [3D Model]  [__RootModelsGroup] 
 [waterA]  [waterA1] in the [Explorer] tab.

waterA1 to waterA7

waterB1 to waterB7

1. Select!

Select!
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3. Click the [Dynamics] tab.

4. Select [Data]  [DataSource], and click .

5. Select [My Computer]  [Assets]  [Bottled water 
production line]  [Filling machine]  [Tank]  [Timer], 
and click the [OK] button.

6. Set "Data" as follows: 
[Settings]
LowLimit: 10
HighLimit: 19
HideWhen: (data < low) OR (data > high)

3. Click!

Click!

5. Click!

6. Set!
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7. Also set parameters to other objects in the same 
hierarchy in the [Explorer] tab as follows:

Object name Data

DataSource LowLimit HighLimit HideWhen
waterA2 [Assets]  [Bottled water production line] 

 [Filling machine]  [Tank]  [Timer]
20 29 (data < low) OR (data > high)

waterA3 30 39 (data < low) OR (data > high)

waterA4 40 49 (data < low) OR (data > high)

waterA5 50 59 (data < low) OR (data > high)

waterA6 60 69 (data < low) OR (data > high)

waterA7 70 79 (data < low) OR (data > high)

8. Also set parameters to the objects in the [waterB] 
hierarchy in the [Explorer] tab in the same way.

Object name Data

DataSource LowLimit HighLimit HideWhen
waterB1 [Assets]  [Bottled water production line] 

 [Filling machine]  [Tank]  [Timer]
90 99 (data < low) OR (data > high)

waterB2 100 109 (data < low) OR (data > high)

waterB3 110 119 (data < low) OR (data > high)

waterB4 120 129 (data < low) OR (data > high)

waterB5 130 139 (data < low) OR (data > high)

waterB6 140 149 (data < low) OR (data > high)

waterB7 150 159 (data < low) OR (data > high)
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Setting the Size dynamic
Set a dynamic for resizing objects in animation.
The animation of the water being filled in the tank and container is realized by resizing objects.

Operating procedure

1. Select [3D View]  [3D Model]  [__RootModelsGroup] 
 [tankwater] in the [Explorer] tab.

2. Select the [Dynamics] tab, and click .

tankwater drinkwater

Select!

Click!
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3. Set "Data" as follows in the same way as for the Hide 
dynamic parameters: 
[Settings]
DataSource: [Assets]  [Bottled water production line] 
 [Filling machine]  [Tank]  [Level gauge]  
[Volume of water in the tank]
LowLimit: 0
HighLimit: 20

4. Select [3D View]  [3D Model]  [__RootModelsGroup] 
 [drinkwater] in the [Explorer] tab.

5. Set "Data" as follows in the same way as for the Hide 
dynamic parameters: 
[Settings]
DataSource: [Assets]  [Bottled water production line] 
 [Filling machine]  [Tank]  [Level gauge]  
[Volume of water in the container]
LowLimit: 0
HighLimit: 20

3. Set!

Select!

5. Set!
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4.8 Checking the Operation on the Graphic Screen
This section describes how to check the operation on the graphic screen in Runtime mode.

Operating procedure

1. Set the RUN/STOP/RESET switch of the CPU module 
to the RUN position.

2. Click the [Runtime] button.

3. Touch the [Start] button on the GOT.

4. The system starts its operation and the animation starts. 
[Lamp]
Run: On

Click!

Touch!
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5. Touch the [Pause] button on the GOT.

6. The system stops its operation and the animation stops. 
[Lamp]
Run: Off

7. Touch the [Stop] button on the GOT.

8. The system stops its operation and the animation 
returns to default. 
[Lamp]
Run: Off

Touch!

Touch!
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4.9 Creating a Trend Graph
This section describes how to create a trend graph using the TrendWorX64 Viewer.

Setting a trend graph
Display the air pressure in the tank in a trend graph.
A trend graph displays the air pressure in the tank when equipment properties are set.

Placing a trend graph viewer

Operating procedure

1. Click the [TrendWorX64 Viewer] button in the [Controls] 
tab, and drag the cursor to place the viewer in a desired 
size.

Click!
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Setting a trend graph (TrendWorX64 Viewer)

Operating procedure

1. Double-click the trend graph viewer.

2. Set the following in the [Appearance] tab: 
[Settings]
Title: Selected
Text: Air pressure in the tank
Text justification:  (left align)
Bold: Selected
Size: 14
Color: Gray (R: 127, G: 127, B: 127)

1. Double-click!

2. Set!
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Setting a trend graph (chart)

Operating procedure

1. Select [TrendWorX64 Viewer]  [Tab]  [Chart] in the 
tree.

2. Set the following in the [Chart] tab: 
[Settings]
Background: Black (R: 0, G: 0, B: 0)
Plot Area: Navy (R: 0, G: 16, B: 48)
"X Axis"
Color: Gray (R: 127, G: 127, B: 127)
Stroke thickness: 2
"Y Axis"
Color: Gray (R: 127, G: 127, B: 127)
Stroke thickness: 2

3. Set the following in the [X Axis] tab: 
[Settings]
Automatic Time Alignment: Selected

4. Click the [Style] button.

2. Set!

1. Select!

3. Set! 4. Click!
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5. Set "Axis Configuration" as follows: 
[Settings]
"Appearance"
Stroke: Gray (R: 127, G: 127, B: 127)
"Show Title"
Show Title: Selected
Text: Elapsed time
"Labels"
Font Family: Yu Gothic UI
Color: Gray (R: 127, G: 127, B: 127)

6. Click the [OK] button.

7. Set the following in the [Y Axis] tab: 
[Settings]
Shared Value Axis: Selected

8. Click the [Configure] button.

6. Click!

5. Set!

8. Click!7. Set!
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9. Set "Shared Axis Configuration" as follows: 
[Settings]
"TITLE"
Show Title: Selected
Title: Air pressure
"STYLE"
Stroke: Gray (R: 127, G: 127, B: 127)
Label Color: Gray (R: 127, G: 127, B: 127)
Label Font Family: Yu Gothic UI

10.Click the [OK] button.9. Set!

Click!10.
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Setting a trend graph (pen)

Operating procedure

1. Select [TrendWorX64 Viewer]  [Tab]  [Chart]  [Plot] 
 [Pen] in the tree.

2. Set the following in the [General] tab: 
[Settings]
Data Source: [Assets]  [Bottled water production line] 
 [Filling machine]  [Tank]  [Level gauge]  [Air 
pressure in the tank]
Connection: Autodetect

3. Set the following in the [Style] tab: 
[Settings]
Stroke: Red (R: 128, G: 0, B: 0)
Stroke thickness: 3

4. Click the [Close] button.

5. A trend graph is created based on the settings.

2. Set!1. Select!

3. Set!

4. Click!
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4.10 Checking the Operation of the Trend Graph
This section describes how to check the operation of the created trend graph in Runtime mode.

Operating procedure

1. Click the [Runtime] button.

2. Touch the [Start] button on the GOT.

3. Change of the trend graph can be monitored in 
accordance with the animation.

4. Touch the [Stop] button on the GOT.

Click!

Touch!

Touch!
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4.11 Setting an Alarm
Setting a real-time alarm
Set a real-time alarm using the Hyper Alarm Server.

Setting an alarm type
Create an alarm type (alarm definition) using the Hyper Alarm Server.
The following is the alarm type setting procedure.

In this exercise, we add settings to the existing high limit alarm so that the low low limit and low limit alarms can also be 
detected. (We change the settings of the alarm type "Limit".)
The settings in the following tabs remain unchanged.
 • [Fields] tab
 • [Triggers] tab
 • [Settings] tab

Page 47 Creating a database

Page 88 Setting an alarm type (conditions)

Page 89 Setting an alarm type (inputs)

Page 94 Setting an alarm type (general)

Page 97 Setting an alarm type (values)

1. Creating alarm types

2. Setting alarm conditions

Where to set: [Conditions] tab

3. Setting input items required for alarms

Where to set: [Inputs] tab

4. Setting fields sent to the client

Where to set: [Fields] tab

5. Setting the expression for the processing of alarms

Where to set: "Expression" in the [General] tab

6. Setting when alarms should be evaluated

Where to set: [Triggers] tab

7. Setting field values sent to the client

Where to set: [Values] tab

8. Setting alarm details if necessary

Where to set: [General] tab, [Settings] tab, 

"Expression" in the [Conditions] tab
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Setting an alarm type (conditions)
Add the low low limit and low limit alarm conditions.

Operating procedure

 • At least one normal condition and one alarm condition must be set.
 • Set "0" to the code for the normal condition.

1. Start the Workbench, and select [MyProject 
(01.00.000.00)]  [Alarms and Notifications]  [Hyper 
Alarm Server]  [Types]  [Limit] in the "Project 
Explorer" window. Double-click [Limit].

2. Select the [Conditions] tab.

3. Click the [Add] button.

4. Set [Code] and [Name] as follows: 
[Settings]
Code: -2
Name: LoLo

5. Add the settings to the Lo limit alarm condition in the 
same way. 
[Settings]
Code: -1
Name: Lo

6. Click the [Apply] button.

1. Double-click!

4. Set!
3. Click!

2. Select!

6. Click!
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Setting an alarm type (inputs)
Add values to the input items required for the low low limit and low limit alarms.
The values set in the [Inputs] tab are displayed on the alarm setting screen. (For details, refer to Page 102 Setting an Alarm.)

■[Inputs] tab

■Alarm setting screen

In this exercise, we add values for the LoLo and Lo conditions.

*1 This is a wait time before the alarm status changes.
*2 This is set to determine whether to require an alarm acknowledgement response. 

false (Deselected on the alarm setting screen): When an alarm is cleared, the alarm will no longer be displayed. 
true (Selected on the alarm setting screen): Even after an alarm is cleared, the alarm will continue to be displayed until an alarm 
acknowledgement response is returned.

Input item Description

Category Display Name
General Settings Data Source Data source of the alarm

Severity Severity of the alarm

Delay Alarm delay*1 setting

Deadband Deadband of the alarm

LoLo Condition Value Threshold value for the low low limit alarm

Message Text Message text for the low low limit alarm

Requires Ack Setting of the low low limit alarm acknowledgment response request*2

Lo Condition Value Threshold value for the low limit alarm

Message Text Message text for the low limit alarm

Requires Ack Setting of the low limit alarm acknowledgement response request*2

Return To Normal Message Text Message text for the normal condition

Hi Condition Value Threshold value for the high limit alarm

Message Text Message text for the high limit alarm

Requires Ack Setting of the high limit alarm acknowledgement response request*2

The items set in the [Inputs] tab 

are displayed in the order 

in which they are set.
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Operating procedure

1. Select the [Inputs] tab.

2. Right-click on the [Return To Normal] row, and select 
[Add at this position].

3. Click  to open the "Category" browser.

4. Select "LoLoCondition".

5. Click the [OK] button. The selected category is enclosed 
in dollar signs as shown below.

1. Select!

2. Select!

3. Click!

4. Select!

5. Click!
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6. Click  to open the "Display Name" browser.

7. Select "Value".

8. Click the [OK] button. The selected display name is 
enclosed in dollar signs as shown below.

9. Set the following: 
[Settings]
Name: LoLoValue
Input Type: Constant
Constant Type: Float64 (64 bit floating point number 
double precision)

6. Click!

7. Select!

8. Click!

9. Set!
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10.Set parameters for other input items in the same way.

Settings

Category Name Display Name Input Type Constant Type Browse Types Default Value
$LoLoCondition$ LoLoMessageText $MessageText$ Constant Character (single 

character)
Language Aliases "LoLo Alarm"

$LoLoCondition$ LoLoRequiresAck $RequiresAck$ Constant Boolean None true

$LoCondition$ LoValue $Value$ Constant Float64 (64 bit floating 
point number double 
precision)

None Blank

$LoCondition$ LoMessageText $MessageText$ Constant Character (single 
character)

Language Aliases "Lo Alarm"

$LoCondition$ LoRequiresAck $RequiresAck$ Constant Boolean None true

11. Click the [Apply] button.

11. Click!
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 • Category, Display Name: Names of the input items displayed on the alarm setting screen*1. The following 
items are provided in GENESIS64 and can be selected from the "Select item with available localization" 
dialog box. When you set names on your own, directly enter the names. (Neither dollar signs nor double 
quotes are required.)

 • Name: An input value identification name (variable) used inside alarm type configuration
 • Description: A description of the input item. This appears as a tooltip at entry on the alarm setting screen*1.
 • Input Type: An input type. Select one of the following values: "Constant", "Dynamic", or "Historical".
 • Constant Type: A data type. This item is set when "Input Type" is set to "Constant".
 • Browse Types: Language alias browser*2 or file browser to be used to select a value on the alarm setting 

screen*1

 • Default Value: A default value for the given input. When "Constant Type" is set to "Character (single 
character)", the entered values need to be enclosed in double quotes.

 • Is Main Input: Select this checkbox to use the settings configured*1 in the [Real-time Data] or [Historical 
Data] tab*3 of AssetWorX as the main input. This can be set to only one input item of each alarm type. For 
the alarm type "Limit", this is set to "Data Source" in the "General Settings" category.

*1 For details, refer to Page 102 Setting an Alarm.
*2 This browser is used to switch the display language on the graphic screen. (The browser is not used in this exercise.)
*3 When "Input Type" is set to "Dynamic", the settings in the [Real-time Data] tab are used. When "Input Type" is set to "Static", the settings 

in the [Historical Data] tab are used.

Select item with available 
localization

AdvancedSettings
Alarm
GeneralSettings
HiCondition
HiHiCondition
LoCondition
LoLoCondition
Normal
RelatedValues

DataSource
Deadband
DefaultDisplay
Delay
Instructions
MessageText
RequiresAck
Severity
Value

BaseText

Select item with available 
localization

<Category> <Display Name>
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Setting an alarm type (general)
Add the low low limit and low limit alarm conditions to the expression for the processing of alarms.
In the [General] tab, set an expression that determines which of the conditions set in the [Condition] tab is used for which 
alarm.
In this exercise, the following expression is set.

■[General] tab

■[Conditions] tab

When the data source is less than or 
equal to the high limit threshold value, 
the Hi Condition is used.

When the data source is less than or 
equal to the low low limit threshold value, 
the LoLo Condition is used.

When the data source is less than or 
equal to the low limit threshold value, 
the Lo Condition is used.

When the data source does not apply 
to the first three lines of the expression, 
the Return to Normal is used.
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Operating procedure

 • A logical expression can also be entered by selecting it from the menu that appears when the [Logical] 
button is clicked.

 • An operator can also be entered by selecting it from the menu that appears when the [Relational] button is 
clicked.

 • The segments enclosed in double curly brackets are variables (the names set in the [Inputs] tab). Each of 
the names can be entered also by selecting it from the data browser that appears when the [Variables] 
button is clicked.

1. Select the [General] tab.

2. Set "Expression" as follows:

1. Select!

The list of the names set in the 

[Inputs] tab is displayed.
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 • The segments enclosed in a pair of a slash with an asterisk are comments that help understand the 
expression. The comments should be entered manually.

3. Click  to check that the expression has no error.

4. Click the [Apply] button.

3. Click!

4. Click!
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Setting an alarm type (values)
Set field values for the low low limit and low limit alarm conditions.
In this exercise, we set values to the fields that have already been set in the [Fields] tab. The entered values are used as the 
field values as they are.

Operating procedure

1. Select the [Values] tab.

2. Double-click the cell of the "LoLo" row in the "Message" 
column.

3. Click .

4. Click the [Variables] button.

5. Select "LoLoMessageText".

6. Click the [OK] button. The selected value is enclosed in 
double curly brackets as shown below.

2. Double-click!

1. Select!

3. Click!

4. Click!

6. Click!

5. Select!
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 • The default values set in the [Field] tab are displayed in blue. When edited, the values are displayed in 
black.

7. Click  to check that the expression has no error.

8. Click the [OK] button.

9. Set a value to the other items in the same way.

10.Click the [Apply] button.

Target row Settings

Condition Name Message RequiresAck
LoLo Set {{LoLoRequiresAck}}

Lo {{LoMessageText}} {{LoRequiresAck}}

6. Click!

8. Click!

10. Click!
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Setting an alarm type (expression of the condition)
Add expressions to the low low limit and low limit alarm conditions.
The expression in the [Conditions] tab is set to switch the condition of an alarm after the condition has been evaluated with the 
expression in the [General] tab. Set the expression only when necessary.
In this exercise, we set an expression considering a deadband.

Operating procedure

1. Copy the expression in the [General] tab.

2. Select the [Conditions] tab.

3. Select "-2:LoLo".

4. Paste the expression copied in Step 1 into the 
"Expression" field.

5. Add the segments of the expression (within the frames 
below) referring to the procedure described on Page 94 
Setting an alarm type (general).

1. Copy!

2. Select!

3. Select!

4. Paste!
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 • An expression can be entered also by selecting it from the menu that appears when the [Arithmetic] button 
is clicked.
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6. Click  to check that the expression has no error.

7. Paste the expression copied in Step 1 into the 
"Expression" field for "-1:Lo", and add the segments of 
the expression (within the frames below).

8. Click  to check that the expression has no error.

9. Paste the expression copied in Step 1 into the 
"Expression" field for "1:Hi", and add the segments of 
the expression (within the frames below).

10.Click  to check that the expression has no error.

11. Click the [Apply] button.

6. Click!

8. Click!

10. クリック！10. Click!

11. Click!
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Setting an alarm
Set threshold values and alarm messages to be displayed to the equipment properties using AssetWorX.

Operating procedure

 • The default values set to the alarm type are displayed in blue. When edited, the values are displayed in 
black.

 • When "Constant Type" is set to "Character (single character)", the entered values need to be enclosed in 
double quotes.

1. Select [MyProject (01.00.000.00)][Assets]  
[Equipment]  [Bottled water production line]  [Filling 
machine]  [Tank]  [Level gauge]  [Air pressure in 
the tank] in the "Project Explorer" window. Double-click 
on [Air pressure in the tank].

2. Select the [Alarm] tab, and set the following: 
[Settings]
Hyper Alarm Server alarm: Selected
Type: Limit
"General Settings"
Severity: 500
"LoLo Condition"
Value: 0
Message Text: "The air pressure in the tank is not being 
monitored."
"Return To Normal"
Message Text: "The air pressure in the tank is normal."
"Hi Condition"
Value: 40
Message Text: "The air pressure in the tank is high, and 
therefore air exhaust is required."

3. Click the [Apply] button.

1. Double-click!

2. Set!

3. Click!
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Setting a historical alarm
Set a historical alarm using the AlarmWorX64 Logger.
Specify alarms to be logged, and set logging configuration and a table for storing alarms.

Setting an alarm configuration

Operating procedure

1. Select [MyProject (Ver. 01.00.000.00)]  [Alarms and 
Notifications]  [AlarmWorX64 Logger]  
[Configurations] in the "Project Explorer" window. Right-
click on [Configurations], and select [Add Configuration].

2. Set the following: 
[Settings]
Name: Alarm_Logger_Setting
Table Name: Alarm_Logger_Table

3. Select the [Alarm Subscription] tab, and click .

1. Select!

2. Set!

3. Click!
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4. Select [My Computer]  [Alarms and Notifications]  
[Hyper Alarm Server]  [!Assets]  [Bottled water 
production line], and click the [OK] button.

5. Click the [Apply] button.

4. Click!

5. Click!
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Adding a node

Operating procedure

1. Select [AlarmWorX64 Logger]  [Nodes]. Right-click on 
[Nodes], and select [Add Node].

2. Set the following: 
[Settings]
Name: Personal computer model name*1

Configuration Name: Alarm_Logger_Setting
*1 Enter the model name of the personal computer used.

3. Click the [Apply] button.

1. Select!

2. Set!

3. Click!
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Setting the AlarmWorX64 Logger
Operate the AlarmWorX64 Logger in the background.
Switch the icon to green to start operation.

Operating procedure

1. Select [AlarmWorX64 Logger].

2. Click the [Alarm Logger] icon in the [Home] tab.

3. Click the [OK] button.

4. Check that the [Alarm Logger] icon has turned green.

1. Select!

2. Click!

Click!3.
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4.12 Creating an Alarm Viewer
This section describes how to create an alarm viewer using the AlarmWorX64 Viewer.
Both real-time and historical alarms can be viewed by switching tabs.

Creating a real-time alarm viewer
A real-time alarm viewer displays the latest alarm occurred when the air pressure in the tank becomes abnormal.

Placing an alarm viewer

Operating procedure

1. Click the [AlarmWorX64 Viewer] button in the [Controls] 
tab, and drag the cursor to place the viewer in a desired 
size.

Click!
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Setting an alarm viewer (tab)

Operating procedure

1. Double-click the alarm viewer.

2. Select [AlarmWorX64 Viewer]  [Tab] in the tree.

3. Set the following in the [Appearance] tab: 
[Settings]
Text: Real-time alarm

Double-click!

2. Select!

3. Set!
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Setting an alarm viewer (grid)

Operating procedure

1. Select [AlarmWorX64 Viewer]  [Tab]  [Grid] in the 
tree.

2. Click , and select [Real Time Subscription].

3. Select "Local Alarm Server", and click .

4. Click .

2. Select!
1. Select!

3. Click!

4. Click!
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5. Select [My Computer]  [Alarms and Notifications]  
[Hyper Alarm Server]  [!Assets]  [Bottled water 
production line], and click the [OK] button.

6. Select the [Appearance] tab.

7. Set the following: 
[Settings]
Grid Style: Media Player

5. Click!

7. Set!

6. Select!
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8. Select the [Column] tab.

9. Select "Tag", and set the following: 
[Settings]
Width: 380

10.Click .

11. Select "Quality", and set the following: 
[Settings]
Visible: Deselected

12.Click .

13.Select "Description", and set the following: 
[Settings]
Width: 250

14.Click .

10. Click!

9. Set!

8. Select!

Select!9.

12. Click!

11. Set!
11. Select!

14. Click!

13. Select!13. Set!
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Creating a historical alarm viewer
A historical alarm viewer displays all alarms occurred when the air pressure in the tank becomes abnormal.

Adding a tab

Operating procedure

Setting an alarm viewer (tab)

Operating procedure

1. Right-click on [AlarmWorX64 Viewer] in the tree, and 
select [Add]  [Tab].

1. Select the added tab.

2. Set the following in the [Appearance] tab: 
[Settings]
Text: Historical alarm

1. Select!

1. Select!

2. Set!
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Setting an alarm viewer (grid)

Operating procedure

1. Select [Grid] of the added tab.

2. Click , and select [Historical Subscription].

3. Select "Local Alarm Server", and click .

1. Select! 2. Select!

3. Click!
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4. Click .

5. Select [My computer] [Alarms and Notifications]  
[Alarm Logger]  [Alarm_Logger_Setting]  [alms:/!ac/
Bottled water production line], and click the [OK] button.

6. Select the [Column] tab.

7. Select "Tag", and set the following: 
[Settings]
Width: 380

8. Click .

4. Click!

5. Click!

8. Click!

7. Set!

6. Select!

7. Select!
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9. Select "Quality", and set the following: 
[Settings]
Visible: Deselected

10.Click .

11. Select "Description", and set the following: 
[Settings]
Width: 250

12.Click .

13.Click the [Close] button.

10. Click!

9. Select! 9. Set!

12. Click!

11. Select!

11. Set!

13. Click!
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14.An alarm viewer is created based on the settings.
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4.13 Checking the Operation of the Alarm Viewer
This section describes how to check the operation of the created alarm viewer in Runtime mode.

Operating procedure

1. Click the [Runtime] button.

2. The following message is displayed in the real-time 
alarm viewer before the system starts its operation. 
[Alarm]
The air pressure in the tank is not being monitored.
[Lamp]
Normal: Off
Error: On

3. Touch the [Start] button on the GOT.

4. The following message is displayed in the real-time 
alarm viewer when the air pressure in the tank is 
normal. 
[Alarm]
The air pressure in the tank is normal.
[Lamp]
Normal: On
Error: Off

Click!

Touch!
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5. The following message is displayed in the real-time 
alarm viewer when the air pressure in the tank is 
abnormal. 
[Alarm]
The air pressure in the tank is low, and therefore air 
intake is required.
The air pressure in the tank is high, and therefore air 
exhaust is required.
[Lamp]
Normal: Off
Error: On

The real-time alarm is regularly updated. To 
check the current alarm, touch the [Pause] 
button on the GOT.

6. Click the [Historical alarm] tab.

7. You can view all the alarms occurred.
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5 EXERCISE 2 DIRECT CONNECTION USING 
MES INTERFACE MODULE

5.1 Overview
In this exercise, we visualize data stored in an SQL Server database with GENESIS64. We use the data stored in an SQL 
Server database by the MES interface module.
The data collection operation by the MES interface module described here is the same operation that we provide in the basic 
training course for the MES interface module.

Precautions
 • The following operations are not included in this exercise: setting SQL Server, setting the MES interface module, and 

creating a database table. (These operations are explained in the basic training course for the MES interface module.)
 • Before starting this exercise, write the project created using GX Works3, "school_MES.gx3", to the CPU module. For the 

writing method, refer to the following.
Page 29 Writing parameters to the CPU module

MES interface module
The MES Interface module enables improved productivity and product quality through its direct connectivity between the 
programmable controller of production equipment and the information system database. Conventionally, a gateway personal 
computer that performs polling processing for checking the devices and programs of the programmable controller was 
required to link information. With the MES interface module, however, information can be linked directly between the 
programmable controller and the database when an event-driven condition is satisfied. The direct connection with the 
database using the MES interface module will decrease system complexity, improve reliability, and reduce the risk of losing 
data. This enables users to reduce the total system configuration and maintenance cost.

SQL

Database

Conventional information linkage via 
a gateway personal computer

Information linkage using the MES interface module

<Manufacturing execution system> <Manufacturing execution system>
Information system 

(Database)
Information system 

(Database)

<Communication gateway> Event 
transmissionHost information system 

communication processing

Data processing (including operation 
processing and data logging)

Computerization via a 
communication gateway is 

not required.
Controller communication

Polling 
processing

<Production 
equipment>

<Production 
equipment>
<Production 
equipment>

MES interface moduleCommunication module

CPU module 
(Device data)

CPU module 
(Device data)
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Operation explained in the basic training course for the MES interface module
The following is the simple data collection operation explained in the basic training course for the MES interface module.

■Overview
The water filling process automated by the programmable controller system is used as an example to explain the data 
collection operation.

■Operation
The following shows the operation between the control system and the production control database.

1. Select a production pattern (1, 2, or 3) on the GOT.

2. Touch the [Production information acquisition] button on the GOT.

3. Acquire the production information.

4. Touch the [Production start] button on the GOT.

5. Distribute the production results.

Process Description
(1) Production control Inputs production patterns and starts/stops the production.

(2) Production Fills water into large, medium, or small containers based on the operation pattern selected.

(3) Quality determination Inspects the volume of water in containers and rejects non-conforming containers.

• Pattern 1: Filling water into small containers (size: S, production plan volume: 40, specified weight: 100)
• Pattern 2: Filling water into medium containers (size: M, production plan volume: 60, specified weight: 150)
• Pattern 3: Filling water into large containers (size: L, production plan volume: 80, specified weight: 200)

 Database   MES interface module   CPU module
• The MES interface module acquires the production information (size, production plan volume, and specified weight) from a table in the production 

control database before starting the production.
• Water is filled into containers in accordance with the production plan volume. Finished containers are inspected. If the volume of water in a container is 

less than the specified value (weight), the container is rejected. The first letter of each container ID indicates the size.

 CPU module   MES interface module   Database
• The MES interface module collects data, such as container IDs, production date and time, and quality determination results, and transfers the data to the 

production control database.

(3)(2)(1)

200 160




 n1     2018-10-01 10:00:00.000    2

n2     2018-10-01 10:00:01.000    1

nxx    2018-10-01 10:01:00.000    1

Control system (CPU module, 
MES interface module) Size (S/M/L), Production plan volume 

(40/60/80), Specified weight (100/150/200) Production control database

Production information acquisition

Production result distribution
Database
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■Data to be stored in the database
The following data is stored in the tables of the database.
 • Project table

Production information: Production pattern, size, production plan volume, specified weight
(The values are fixed.)

 • Judgement table
Production results: Container ID, production date and time, quality determination result, total number of accepted products, 
total number of rejected products
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■Devices used in the sequence program

Precautions
 • This manual does not cover the devices of the Simple Motion module and the servo amplifier. For details, refer to the user's 

manual for each module used.
 • Programming is not included in this exercise. The pre-programmed project "school_MES.gx3" is used.

Device name Description Device name Description
X20 Ready M4 Production end trigger

X21 Synchronization flag C0 The contact turns on when the count value reaches the 
value set in D100.

X200 Production start D0, D1000 Production pattern

X300 Production information reset D100 Production plan volume

Y20 Programmable controller ready D110 Specified weight

Y21 All axes servo ON D120 Production size

SM400 Always On D129 Random number

SM403 After RUN, OFF for 1 scan only D130 Random number (container weight)

SM415 Repeatedly turns on/off at an interval specified in 
SD415.

D140 Quality determination result

SM705 Number of conversion digits selection D150 Total number of accepted products

SD415 'n' for the 2n ms clock D160 Total number of rejected products

M1 Production start trigger D200 Total production

M2 Quality determination start trigger D210 Container ID (size part)

M3 Quality determination result storing trigger D211 Container ID (numerical part)
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■Sequence program
For details on each instruction, refer to the following.
MELSEC iQ-R Programming Manual (Instructions, Standard Functions/Function Blocks)
 • MES

1

2 (0)
SM400 Y20

3 (11)
X20 X21 Y20 Y21

4 (15)
SM403

= D0 K3 DMOVP K360000 U2\G4318

5 = D0 K2 DMOVP K240000 U2\G4318

6 = D0 K1 DMOVP K121000 U2\G4318

7

8 (46)
X200

SET M1

9 (55)
M1

RND D129

10 SET X201

11 (59)
SM400

MOV K500 SD415

12
SM705

13 (63)
SM415

MOVP D129 D130

14
M2

15

16 (68)
M2 M4 M1

> D130 K0 <= D130 K26213 MOV K1 D140

17 = D130 K0
M1

18 >= D130 K26214 <= D130 K32767 MOV K2 D140

19 INC D200

20
M3

21 (106)
M3

= D140 K1 INC D150

22 OUT C0 D100

23 = D140 K2 INC D160

24 (123)
X201 M4 U2\G30101.0

25 (129)
C0 M4

26

27 (131)
M3

BINDA D200 D211

28 MOV D120 D210

121 2 3 4 5 6 7 8 9 10 11

SM412

Servo initial setting

Production processing

Quality determination

Container ID creation
5  EXERCISE 2 DIRECT CONNECTION USING MES INTERFACE MODULE
5.1  Overview 123



12
 • GENESIS64

29

30 (145)
M4

OUT T0 K20

31 (160)
X300

RST C0

32
T0

RST D0

1 2 3 4 5 6 7 8 9 10 11 12

33 RST M1

34 RST M4

35 RST X201

36 RST X300

37 RST X200

38 RST D100

39 RST D110

40 RST D120

41 RST D129

42 RST D130

43 RST D140

44 RST D150

45 RST D160

46 RST D200

47 RST D210

48 RST D211

49 RST D212

50 (198) END

Production information reset

1 (0)
SM403

> D0 0
M1

MOV D0 D1000

2 (7) END

1 2 3 4 5 6 7 8 9 10 11 12
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Screen to be created
The following is the screen to be created in this exercise.
This section describes how to display data stored in the database on the Production Status Monitor screen.

*1 The display can be changed by switching tabs.

No. Name Description
(1) Production status The production plan volume and the number of accepted/rejected products per production 

pattern are displayed in numerical values.
The display can be switched for each pattern.

(2) Production status (by size) The production plan volume and the number of accepted products per production pattern are 
displayed in a bar graph.

(3) Quality information*1 Historical information on rejected products is displayed in a list.

(1)

(2)

(3)
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Operation of GOT screen
This section describes how to operate the GOT screen.
Use GOT2000.

No. Name Description
(1) Production pattern selection Selects a production pattern.

1: Small container
2: Medium container
3: Large container

(2) Production information acquisition Acquires the production information of the selected production pattern.

(3) Production start Starts the production based on the acquired production information.

(4) Production stop/reset Stops the production.

(1)

(3)

(2)

(4)
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5.2 Operating Procedure
The following is the operating procedure of this exercise.

Operating procedure

Page 128 Creating Data Sources

Page 133 Creating a tag

Page 134 Configuring the Asset Tree

Page 141 Setting Data to be Displayed on the Production Status Screen

Page 143 Checking the Operation of the Production Status

Page 146 Creating the Production Status (by Size) Screen

Page 153 Checking the Operation of the Production Status (by Size)

Page 156 Creating the Quality Information Screen

Page 161 Checking the Operation of the Quality Information

1. Creating data sources 
Tool: Workbench

2. Creating tags that are associated with devices in 
the programmable controller
Tool: Workbench

3. Building the asset tree
Tool: Workbench

4. Setting data to be displayed on the Production 
status screen
Tool: GraphWorX™64

5. Checking the operation of the production status 
Tool: GraphWorX™64

6. Setting data to be displayed on the Production 
status (by size) screen
Tool: GraphWorX™64

7. Checking the operation of the production status 
(by size)
Tool: GraphWorX™64

8. Setting data to be displayed on the Quality 
information screen 
Tool: GraphWorX™64

9. Checking the operation of the quality information 
Tool: GraphWorX™64
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5.3 Creating Data Sources
This section describes how to import project data in the Workbench and create data sources.
Data sources define which information is acquired from which database and have been set in the project data.

Importing project data
Import project data in the Workbench.

Operating procedure

1. Start the Workbench, and select [MyProject 
(01.00.000.00)]  [Data Connectivity]  [Databases]  
[SQL Connections] in the "Project Explorer" window. 
Right-click on [SQL Connections], and select [Import].

2. Click  to open the "File" browser.

3. Select the "Setting_Workbench.csv" file, and click the 
[Open] button.

1. Select!

2. Click!

Click!
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4. Click the [OK] button.

5. Right-click on [SQL Connections] in the "Project 
Explorer" window, and select [Refresh].

6. The imported data sources are displayed in the "Project 
Explorer" window.

4. Click!

5. Select!
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Setting data
The following are the details of the imported data sources.

*1  indicates the size (S/M/L).

Data source 
name

Description Table Displayed location 
in the screen

actual_*1 Acquires the total number of accepted 
products from the Judgement table.

• Project table

• Judgement table

Production status

ActualGraph_*1 Acquires the size from the Project 
table and the total number of accepted 
products from the Judgement table.

Production status (by 
size)

bad_*1 Acquires the total number of rejected 
products from the Judgement table.

Production status

Bad_List_*1 Acquires the container ID, production 
date and time, and total number of 
rejected products from the Judgement 
table.

Quality information

Plan_*1 Acquires the production plan volume 
from the Project table.

Production status

PlanGraph_*1 Acquires the size and production plan 
volume from the Project table.

Production status (by 
size)
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Setting a database to be connected
Set a connection target database of the imported data sources in accordance with the personal computer used as a database 
server.

Operating procedure

1. Double-click [Bottle_judge], and click "(Configure 
Connection)".

2. Set the SQL Server connection settings as follows: 
[Settings]
Select or enter a server name:
(Personal computer name used as a database 
server)\(SQL Server instance name)*1*2

Enter information to log on to the server:
Use Windows NT Integrated Security (service user)
Select the database on the server: master

*1 The server name can be checked by starting SQL Server 
Management Studio.

*2 In the window shown on the left, the following are set:
Personal computer name: DESKTOP-l1V94GS
Instance name: SQLEXPRESS

3. Click the [OK] button.

1. Click!

Set!

Click!
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4. Click "(Test Connection)".

5. Check that the connection with the database has been 
successfully established.

6. Click the [OK] button.

7. Click the [Apply] button.

4. Click!

Click!

7. Click!
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5.4 Setting a Tag
This section describes how to set a tag in the Workbench.

Creating a tag
Add a tag to be used in Exercise 2 to the communication target device used in Exercise 1.
Set a device for switching the production status between the production patterns as a tag.

Operating procedure

1. Start the Workbench, and select [MyProject 
(01.00.000.00)]  [Data Connectivity]  [Mitsubishi 
Electric]  [R04_1(R04)]  [TagGroup] in the "Project 
Explorer" window. Double-click [TagGroup].

2. Click the "+ Click here to add new item" link under "Tag 
Settings", and set the following:

Settings Description

Name Enable Use Tag name for 
I/O Address

I/O Address Data Type Polling Rate

Tag004 Selected Deselected D1000 WORD Default (1000 
milliseconds)

Production pattern

3. Click the [Apply] button.

1. Double-click!

2. Set!

3. Click!
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5.5 Configuring the Asset Tree
This section describes how to build an asset tree in the Workbench.
Add the following equipment properties to be used in Exercise 2 to the asset tree built in Exercise 1.

Equipment Module

Process cell

Unit

Equipment hierarchy
■Structure

Control Module

Bottled water production line

Filling machine

Tank

Level gauge

Equipment configuration

■Asset tree

・ Production plan volume_S

・ Production plan volume_M

・ Production plan volume_L

・ Number of accepted products_S

・ Number of accepted products_M

・ Number of accepted products_L

・ Number of rejected products_S

・ Number of rejected products_M

・ Number of rejected products_L

・ Rejected product list_S

・ Rejected product list_M

・ Rejected product list_L

・ Production pattern

Equipment properties
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Setting equipment properties
Set the data of equipment as equipment properties.
Link equipment properties with data sources and tags set to the Mitsubishi Electric FA Connector.
In this exercise, we set equipment properties related to the production pattern and S size on the setting screen in the 
Workbench. For the properties related to the M size and L size, we define them in an external file and import them from the 
file.

Setting equipment properties

Operating procedure

1. Start the Workbench, and select [MyProject 
(01.00.000.00)]  [Assets]  [Equipment]  [Bottled 
water production line] in the "Project Explorer" window. 
Right-click on [Bottled water production line], and select 
[Add Equipment property].

2. Set the following: 
[Settings]
Name: Production plan volume_S

3. Set the following in the [Real-time Data] tab: 
[Settings]
Source type: Dynamic tag

4. Click  to open the "Real-time data" browser.

5. Select [My Computer]  [Data Connectivity]  
[Databases]  [SQL Server]  [Bottle_judge]  [Data 
Sources]  [Plan_S]  [Columns]  
[ProductionPlanVolume], and click the [OK] button.

1. Select!

4. Click!

2. Set!

3. Set!

5. Click!
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6. Set the following in the [Dataset] tab: 
[Settings]
Dataset tag: Selected

7. Click  to open the "Dataset tag" browser.

8. Select [My Computer]  [Data Connectivity]  
[Databases]  [SQL Server]  [Bottle_judge]  [Data 
Sources]  [PlanGraph_S], and click the [OK] button.

9. Click the [Apply] button.

Set the [Real-time Data] tab to reference 
values on the graphic screen (for example, 
Process Point).
Set the [Dataset] tab to reference data sets 
on the graphic screen (for example, 
GridWorX Viewer).

10.Set the following equipment properties in the same way.

Target equipment Settings

Name Real-time Data Dataset

Source type Real-time data tag Dataset tag
Bottled water production line Number of accepted 

products_S
Dynamic tag [actual_S]  [Columns]  

[TotalNumberOfAcceptedProducts]
Selected [ActualGraph_S]

Bottled water production line Number of rejected 
products_S

Dynamic tag [bad_S]  [Columns]  
[TotalNumberOfRejectedProducts]

Not set

Bottled water production line Rejected product 
list_S

Not set Selected [Bad_List_S]

7. Click!
6. Set!

8. Click!

9. Click!
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11. Set the following equipment property referring to the 
procedure described on Page 54 Setting equipment 
properties.

Target equipment Settings

Name Real-time Data

Source type Real-time data tag
Bottled water production line Production pattern Dynamic tag Tag004
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Importing equipment properties　

Operating procedure

 • Equipment properties to be added

1. Export [Bottled water production line] referring to the 
procedure described on Page 56 Importing equipment 
properties.

2. Open the file exported in Step 1 in Excel. The 
"EquipmentProperty" sheet is displayed.

3. Copy the 2nd to 5th rows to the 11th to 14th rows, and 
change the data as follows:

Target row Settings

Name RealtimePointName DatasetPointName
11th row Production plan 

volume_M
db:Bottle_judge.Plan_M[ProductionPlanVolume][0] db:Bottle_judge.PlanGraph_M

12th row Number of accepted 
products_M

db:Bottle_judge.actual_M[TotalNumberOfAcceptedProducts][0] db:Bottle_judge.ActualGraph_M

13th row Number of rejected 
products_M

db:Bottle_judge.bad_M[TotalNumberOfRejectedProducts][0] Not changed

14th row Rejected product list_M Not changed db:Bottle_judge.Bad_List_M

Settings

Target equipment Name Real-time Data Dataset

Source type Real-time data tag Dataset tag
Bottled water production line Production plan 

volume_M
Dynamic tag [Plan_M]  [Columns]  

[ProductionPlanVolume]
Selected [PlanGraph_M]

Bottled water production line Number of accepted 
products_M

Dynamic tag [actual_M]  [Columns]  
[TotalNumberOfAcceptedProducts]

Selected [ActualGraph_M]

Bottled water production line Number of rejected 
products_M

Dynamic tag [bad_M]  [Columns]  
[TotalNumberOfRejectedProducts]

Not set

Bottled water production line Rejected product list_M Not set Selected [Bad_List_M]
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 • Equipment properties to be added

4. Copy the 2nd to 5th rows to the 15th to 18th rows, and 
change the data as follows:

Target row Settings

Name RealtimePointName DatasetPointName
15th row Production plan 

volume_L
db:Bottle_judge.Plan_L[ProductionPlanVolume][0] db:Bottle_judge.PlanGraph_L

16th row Number of accepted 
products_L

db:Bottle_judge.actual_L[TotalNumberOfAcceptedProducts][0] db:Bottle_judge.ActualGraph_L

17th row Number of rejected 
products_L

db:Bottle_judge.bad_L[TotalNumberOfRejectedProducts][0] Not changed

18th row Rejected product list_L Not changed db:Bottle_judge.Bad_List_L

Settings

Target equipment Name Real-time Data Dataset

Source type Real-time data tag Dataset tag
Bottled water production line Production plan 

volume_L
Dynamic tag [Plan_L]  [Columns]  

[ProductionPlanVolume]
Selected [PlanGraph_L]

Bottled water production line Number of accepted 
products_L

Dynamic tag [actual_L]  [Columns]  
[TotalNumberOfAcceptedProducts]

Selected [ActualGraph_L]

Bottled water production line Number of rejected 
products_L

Dynamic tag [bad_L]  [Columns]  
[TotalNumberOfRejectedProducts]

Not set

Bottled water production line Rejected product list_L Not set Selected [Bad_List_L]
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5. Save the changes to the file.

6. Import the file saved in Step 5 to [Bottled water 
production line] referring to the procedure described on 
Page 56 Importing equipment properties.

7. Check that the equipment properties are added.
0 5  EXERCISE 2 DIRECT CONNECTION USING MES INTERFACE MODULE
5.5  Configuring the Asset Tree



5

5.6 Setting Data to be Displayed on the Production 
Status Screen

This section describes how to display data stored in the database on the Production status screen using GraphWorX64.
Display the values stored in the tables of the database for the following layered objects.

Operating procedure

Object name Display content
S_size Plan Production plan volume of the production pattern 1 (S size)

Actual result Total number of accepted products of the production pattern 1 (S size)

Reject Total number of rejected products of the production pattern 1 (S size)

M_size Plan Production plan volume of the production pattern 2 (M size)

Actual result Total number of accepted products of the production pattern 2 (M size)

Reject Total number of rejected products of the production pattern 2 (M size)

L_size Plan Production plan volume of the production pattern 3 (L size)

Actual result Total number of accepted products of the production pattern 3 (L size)

Reject Total number of rejected products of the production pattern 3 (L size)

1. Open the "Template.gdfx" file, and select [S_size]  
[Plan] in the [Explorer] tab.

2. Select [Data]  [DataSource] in the [Dynamics] tab, and 
click .

Select!

Click!
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3. Select [My Computer]  [Assets]  [Bottled water 
production line]  [Production plan volume_S], and click 
the [OK] button.

4. Set [ActualResult] and [Reject] in the same way. 
[Settings]
[ActualResult]
DataSource: [Assets]  [Bottled water production line] 
 [Number of accepted products_S]
[Reject]
DataSource: [Assets]  [Bottled water production line] 
 [Number of rejected products_S]

5. Set items for M size and L size in the same way.

Object name Data

DataSource
M_size Plan [Assets]  [Bottled water production line]  [Production plan volume_M]

Actual result [Assets]  [Bottled water production line]  [Number of accepted products_M]

Reject [Assets]  [Bottled water production line]  [Number of rejected products_M]

L_size Plan [Assets]  [Bottled water production line]  [Production plan volume_L]

Actual result [Assets]  [Bottled water production line]  [Number of accepted products_L]

Reject [Assets]  [Bottled water production line]  [Number of rejected products_L]

3. Click!

Set!
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5.7 Checking the Operation of the Production Status
This section describes how to check the operation of the production status in Runtime mode.

Operating procedure

1. Write the project for Exercise 2, "school_MES.gx3" to 
the CPU module, and set the RUN/STOP/RESET 
switch of the CPU module to the RUN position. For the 
writing method, refer to the following.
Page 29 Writing parameters to the CPU module

2. Click the [Runtime] button.

3. Touch the [1] button of "Production pattern selection" on 
the GOT.

4. Touch the [Production information acquisition] button.

Click!

Touch!

Touch!
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When the [Production start] button is touched, the following operations are performed.
 • Small containers are produced every about one second.
 • ID numbers are assigned to the finished containers. (ID number: 'Size' + 'Number', for example, S1, S2, S3)
 • Non-conforming containers are rejected.
 • When the number of accepted products reaches the production plan volume, the production stops.
 • The number of revolutions of the servo motor differs depending on the production pattern. (Small container: 

One revolution, Medium container: Two revolutions, Large container: Three revolutions)
 • When the production stops, the servo motor also stops.

5. The production information on the production pattern 1, 
which has been acquired from the database, is 
displayed.

6. Touch the [Production start] button on the GOT.

7. The production progress can be checked in real time on 
the screen of GraphWorX64.

Touch!
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8. Touch the [Production stop/reset] button on the GOT. 
Check the operation of different production patterns in 
the same way.

9. Touch the [Production stop/reset] button on the GOT.

Touch!
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5.8 Creating the Production Status (by Size) Screen
This section describes how to display data stored in the database on the Production status (by size) screen using the 
GridWorX Viewer.

Setting a graph
Set a bar graph display for the production plan volume and actual result per production pattern.

Placing a graph

Operating procedure

1. Click the [GridWorX Viewer] button in the [Controls] tab, 
and drag the cursor to place the graph in a desired size.

If [S_size] is selected in the [Explorer] tab, 
the graph is created within the selected layer. 
The graph is not even displayed depending 
on the production pattern.
In this exercise, place the graph with 
[ProductionStatusBySize] being selected.

1. Click!
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Adding a chart

Operating procedure

1. Double-click the grid viewer.

2. Select [GridWorX Viewer]  [Tab]  [Grid]. Right-click 
on [Grid], and select [Remove].

3. Click the [Yes] button.

1. Double-click!

2. Select!

Click!
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4. Select [GridWorX Viewer]  [Tab]. Right-click on [Tab], 
and select [Add]  [Chart].

4. Select!
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Setting a graph (GridWorX Viewer)

Operating procedure

Setting a graph (chart)

Operating procedure

1. Select [GridWorX Viewer] in the tree.

2. Set the following in the [Appearance] tab: 
[Settings]
Control Background: Gray (R: 89, G: 89, B: 89)

1. Select [GridWorX Viewer]  [Tab]  [Chart] in the tree.

2. Set the following in the [Chart and Axis] tab: 
[Settings]
"X Axis"
Title: Production results by size
Color: White (R: 255, G: 255, B: 255)
"Y Axis"
Color: White (R: 255, G: 255, B: 255)

1. Select!

2. Set!

1. Select!

2. Set!
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3. Select the [Series] tab, and click .

4. Select [My Computer]  [Assets]  [Bottled water 
production line]  [Production plan volume_S], and click 
the [OK] button.

5. Set "Series Properties" as follows: 
[Settings]
Series Title: S size (plan)
Plot Type: Bars
Key Binding: Size
Value Binding: ProductionPlanVolume

6. Click .

3. Click!

4. Click!

5. Set!

6. Click!
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7. Set "Style" as follows: 
[Settings]
Line color: None
Fill: Yellow green (R: 146, G: 208, B: 80)

8. Set other "Series Properties" and "Style" as follows in 
the same way:

Data Source Series Properties Style

Series Title Plot Type Key 
Binding

Value Binding Line 
color

Fill

[Assets]  [Bottled water 
production line]  [Number of 
accepted products_S]

S size (actual result) Bars Size TotalNumberOfAccepted
Products

None Green (R: 0, G: 176, B: 80)

[Assets]  [Bottled water 
production line]  [Production 
plan volume_M]

M size (plan) Bars Size ProductionPlanVolume None Light blue (R: 0, G: 176, B: 240)

[Assets]  [Bottled water 
production line]  [Number of 
accepted products_M]

M size (actual 
result)

Bars Size TotalNumberOfAccepted
Products

None Blue (R: 0, G: 112, B: 192)

[Assets]  [Bottled water 
production line]  [Production 
plan volume_L]

L size (plan) Bars Size ProductionPlanVolume None Orange (R: 255, G: 192, B: 0)

[Assets]  [Bottled water 
production line]  [Number of 
accepted products_L]

L size (actual result) Bars Size TotalNumberOfAccepted
Products

None Yellow (R: 255, G: 255, B: 0)

7. Set!
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9. Select the [Advanced] tab, and set "Common" as 
follows: 
[Settings]
ChartMode: Cluster
ShowLegend: True

10.Set "Common-Style" as follows: 
[Settings]
BorderThickness: 0
Foreground: White (R: 255, G: 255, B: 255)

11. Click the [Close] button.

12.A graph is created based on the settings.

9. Set!

10. Set!

11. Click!
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5.9 Checking the Operation of the Production Status 
(by Size)

This section describes how to check the operation of the production status (by size) in Runtime mode.
At the start of this exercise, the past production data (actual results) has already been displayed in a bar graph on the screen.
When new containers are produced in this exercise, the past production data is reset and the count starts from zero.

Operating procedure

1. Click the [Runtime] button.

2. Touch the [1] button of "Production pattern selection" on 
the GOT.

3. Touch the [Production information acquisition] button.

Click!

Touch!

Touch!
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4. The production information on the production pattern 1, 
which has been acquired from the database, is 
displayed.

5. Touch the [Production start] button on the GOT.

6. The actual result of S size container production can be 
checked in real time on the screen of GraphWorX64.

Touch!
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7. Touch the [Production stop/reset] button on the GOT. 
Check the operation of different production patterns in 
the same way.

8. Touch the [Production stop/reset] button on the GOT.

Touch!
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5.10 Creating the Quality Information Screen
This section describes how to display data stored in the database on the Quality information screen using the GridWorX 
Viewer.

Setting data to be displayed on the Quality information screen
Add quality information of S size containers to those of M/L size containers.

Adding a tab

Operating procedure

1. Click  of [GridWorX Viewer] in the [Explorer] tab to 
show the objects.

2. Double-click the grid viewer.

1. Click!

2. Double-click!
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Setting a table (tab)

Operating procedure

3. Right-click on [GridWorX Viewer] in the tree, and select 
[Add]  [Tab].

1. Select the added tab.

2. Set the following in the [Appearance] tab: 
[Settings]
"Unselected Tab Properties"
Background: Gray*1 (R: 127, G: 127, B: 127)
Border: Black (R: 63, G: 63, B: 63)
Foreground: White (R: 242, G: 242, B: 242)
"Selected Tab Properties"
Background: White (R: 242, G: 242, B: 242)
"Title"
Text: S size

*1 Set the color in the [Solid Color] tab.

3. Select!

2. Set!

1. Select!
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Setting a table (grid)

Operating procedure

1. Select [Grid] of the added tab.

2. Click , and select [Data Set Tag Subscription].

3. Select [My Computer]  [Assets]  [Bottled water 
production line]  [Rejected product list_S], and click 
the [OK] button.

4. Set the following in the [Source] tab: 
[Settings]
Create/Remove subscriptions: S Size

2. Select!1. Select!

3. Click!

4. Set!
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5. Select the [Advanced] tab, and set "Common-Style" as 
follows: 
[Settings]
Background: Gray (R: 127, G: 127, B: 127)
BorderBrush: None
BorderThickness: 0
Foreground: White (R: 255, G: 255, B: 255)

6. Set "Grid" as follows: 
[Settings]
HorizontalGridLineBrush: Black (R: 63, G: 63, B: 63)
VerticalGridLineBrush: Black (R: 63, G: 63, B: 63)

5. Set!

6. Set!
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7. Set "ScrollBar" as follows: 
[Settings]
ScrollBarBackground: Gray (R: 127, G: 127, B: 127)
ScrollBarBorderBrush: None
ScrollBarForeground: White (R: 242, G: 242, B: 242)

8. Click the [Close] button.

9. A table is created based on the settings.

7. Set!

8. Click!
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5.11 Checking the Operation of the Quality Information
This section describes how to check the operation of the quality information in Runtime mode.
At the start of this exercise, the past production data (quality information) has already been displayed in a list on the screen.
When new containers are produced in this exercise, rejected container information is added to the list.

Operating procedure

1. Click the [Runtime] button.

2. Select the [S size] tab to switch the screen for the S size 
quality information.

3. Touch the [1] button of "Production pattern selection" on 
the GOT.

Click!

Select!

Touch!
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4. Touch the [Production information acquisition] button.

5. The production information on the production pattern 1, 
which has been acquired from the database, is 
displayed.

6. Touch the [Production start] button on the GOT.

Touch!

Touch!
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7. The rejected container information is added and 
checked in real time on the screen of GraphWorX64.

8. Touch the [Production stop/reset] button on the GOT. 
Check the operation of different production patterns in 
the same way.

9. Touch the [Production stop/reset] button on the GOT.

Touch!
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APPENDICES
Appendix 1 TCP/IP Settings on a Personal Computer
This section describes how to change TCP/IP settings on a personal computer running Microsoft Windows 10.

Operating procedure

1. Open the Start menu of Windows, and select 
[Windows System]  [Control Panel].

2. The Control Panel appears. Select "View 
network status and tasks".

Select!

Select!
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3. Select "Ethernet".

4. Click the [Properties] button.

Select!

Click!
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5. Select "Internet Protocol Version 4 (TCP/
IPv4)".

6. Click the [Properties] button.

7. Select "Use the following IP address", and set 
the following: 
[Settings]
IP address: 192.168.3.100
Subnet mask: 255.255.255.0

8. Click the [OK] button.

Select!

Click!

Set!

Click!
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9. Click the [OK] button.

10.Click the [Close] button.

Click!

Click!
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Appendix 2 Hyper Alarm
On Page 31 EXERCISE 1 CREATING AN OPERATION MONITORING SCREEN, we set threshold values and alarm 
messages to be displayed to the equipment properties using AssetWorX™. 
Such data can also be set to the alarm tags on the Hyper Alarm Server.
This section describes how to set alarm tags using the alarm type set on Page 87 Setting a real-time alarm.

Precautions
The alarm tags created on the Hyper Alarm Server cannot be migrated to the equipment properties in AssetWorX™.

Setting a real-time alarm

Operating procedure

1. Start the Workbench, and select [MyProject 
(01.00.000.00)]  [Alarms and Notifications]  [Hyper 
Alarm Server]  [Areas] in the "Project Explorer" 
window. Right-click on [Areas], and select [Add Area].

2. Set the following: 
[Settings]
Name: Area

3. Click the [Apply] button.

1. Select!

2. Set!

3. Click!
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4. Right-click on [Area], and select [Add Tag].

5. Set the following: 
[Settings]
Name: Alarm_Tag

6. Set the following in the [Inputs] tab: 
[Settings]
Type: Limit
"General Settings"
Severity: 500
"LoLo Condition"
Value: 0
Message Text: "The air pressure is not being 
monitored."
"Lo Condition"
Value: 20
Message Text: "The air pressure in the tank is low, and 
therefore air intake is required."
"Return to Normal"
Message Text: "The air pressure in the tank is normal."
"Hi Condition"
Value: 40
Message Text: "The air pressure in the tank is high, and 
therefore air exhaust is required."

 • The default values set to the alarm type are 
displayed in blue. When edited, the values 
are displayed in black.

 • For the alarm type setting items that 
require input with a string, enclose the 
input string in double quotes.

4. Select!

5. Set!
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7. Click  to open the "Data Source" browser.

8. Select [My Computer]  [Assets]  [Bottled water 
production line]  [Filling machine]  [Tank]  [Level 
gauge]  [Air pressure in the tank], and click the [OK] 
button.

9. Click the [Apply] button.

7. Click!

8. Click!

9. Click!
APPX
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Setting a historical alarm
Operating procedure

1. Set a historical alarm referring to the procedure 
described on Page 103 Setting a historical alarm. In 
Step 4 of the procedure for setting an alarm 
configuration, set the following as an alarm subscription 
item: 
[Settings]
[My Computer]  [Alarms and Notifications]  [Hyper 
Alarm Server]  [Area]
2 APPX
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Creating a real-time alarm viewer
Operating procedure

1. Create a real-time alarm viewer referring to the 
procedure described on Page 107 Creating a real-time 
alarm viewer. In Step 5 of the procedure described on 
Page 113 Setting an alarm viewer (grid), set the 
following as an event point: 
[Settings]
[My Computer]  [Alarms and Notifications]  [Hyper 
Alarm Server]  [Area]
APPX
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Creating a historical alarm viewer
Operating procedure

1. Create a historical alarm viewer referring to the 
procedure described onPage 112 Creating a historical 
alarm viewer. In Step 5 of the procedure described on 
Page 113 Setting an alarm viewer (grid), set the 
following as an event point: 
[Settings]
[My Computer]  [Alarms and Notifications]  [Alarm 
Logger]  [Alarm_Logger_Setting]  [alms:/Area]
4 APPX
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